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Foreword 
 

This manual has been written for the “Training for strengthening crop yield 
forecasting capacity of the State Administration for Hydrometeorology 
(Hydromet) of Tajikistan” that occurred between 12nd January and 7th 
February 2015 in Arlon – Belgium in the framework of the Food and Agriculture 
Organization (FAO) of the United Nations Project (GCP/TAJ/007/EC) “Support 
to Strengthening the National Food Security Information System in Tajikistan”.  
 
This manual is intended to cover the Remote Sensing part only of the general 
Crop Yield Forecasting System (CYFS). Data and software related to this manual 
are all provided in the training package. Despite written for the Tajik context 
this manual can serve as an example for all other countries. 
 
This manual follows on from the 2 manuals entitled: 

 “FAO Training in Crop Yield Forecasting ARMENIA - Erevan – May 2011 – 
Remote Sensing”.  

 “FAO Training in Crop Yield Forecasting. Improvement of the Crop Yield 
Forecasting System (CYFS) in Armenia: a new approach for satellite data 
integration. ARMENIA - Yerevan - January 2013.” 

 
This manual, in addition to adapt the method to Tajik context, integrates for 
the first time the NDVI images of PROBA-V satellite. These images continue the 
stopped SPOT-VEGETATION time’s series, from 2014 to undefined future.  
 
Currently, the efficiency of the explanatory variables produced by the method 
presented in this manual to predict crop yields of Tajikistan has not been 
assessed yet. Consequently the user should take an experimental approach of 
this method.  
 
This manual has been written by Antoine DENIS: 

Université de Liège (ULg) 
 Avenue de Longwy, 185 

6700 Arlon, Belgium  
Antoine.Denis@ulg.ac.be  

 
 

Cover images (from the top down): PROBA-V satellite, satellite image of Tajikistan, Tajikistan’s 

mountains and lake, fodder harvesters, cotton growers, cotton bolls, Statue of Ismail Samani (Ismoili 

Somoni) in Dushanbe. 

mailto:Antoine.Denis@ulg.ac.be
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1 Introduction 

The ongoing global population growth is leading to food security question. Currently 800 

millions of persons worldwide are undernourished.  

Given this situation, some international organizations, such as the FAO, are working on the 

development of early warning systems for food security tools. In this context and with such 

tools, the University of Liège (ULg) has elaborated its own Crop Yield Forecasting (CYF) 

methodology. This method aims at forecasting crop yield from meteorological, 

agrometeorological and Remote Sensed (NDVI) data with different software.*  

This method has already been applied in different context, for examples: 

 In Senegal for millet, sorghum, maize, cowpea and peanuts (Tychon et Rosillon, 2006 

et Kouadio, 2007) 

 In Burkina Faso for coton (Bronne, 2009) 

 In Armenia for wheat, potato and grape (2013) 

This manual focuses on the Remote Sensing (RS) part of the model only. It is divided in 4 

chapters: 

I. Database production for the first time 

First the general CYF methodology is explained and software used are presented. Then 

the main part of this manual is devoted to the detailed and illustrated description of the 

application of the method to Tajikistan, i.e. where to find satellite NDVI images and how 

to process them to produce desired crop yield explanatory variables. 

II. Database updates and modifications 

How to quickly update the database. 

III. Real time crop yield forecasting 

How to make a real time CYF (during the cropping season with an incomplete NDVI 

images time-series). 

IV. Complementary information for CYFS (optional) 

Some methods are given to produce complementary information that can be used as 

support to the CYF itself. How to create graphs, stress maps, where to find 

complementary information, etc. 

Data and software presented in this manual are provided in the training package. 

* Source : adapted from the  manual « Prévision des rendements agricoles Guide d’utilisation, C.E. Bronne, M. 

Diakité, J. Wellens & B. Tychon, GEEAU project.
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The main updates compared to the previous manuals (confer Foreword) are: 

General: 

 New illustrations of the method and concepts for better understanding 

NDVI images: 

 Use of the NDVI images from the new sensor PROBA-V (available since 21st 

November 2013) in addition and continuity to SPOT VEGETATION NDVI images. No 

METOP AVHRR NDVI image is used anymore in the proposed CYFS. Access to and 

process of these new data is presented. 

 All satellite images (SPOT-VEGETATION, PROBA-V (and also METOP AVHRR)) have 

now to be downloaded from a single website: http://www.vito-eodata.be  

 The website that previously distributed the SPOT VEGETATION images 

(http://free.vgt.vito.be/ ) doesn’t exist anymore and is replaced by the website 

mentioned above.  

Software: 

 The new version of the software VGT EXTRACT has to be used (version 2.1.0) to 

process the SPOT VEGETATION images from the new website. 

 The new software “PROBA-V ProductCustomization Tool” (PPT) has to be used to 

prepare PROBA-V images for TIMESAT. 

 Use of TIMESAT software, instead of VAST, for the temporal smoothing of NDVI 

images and the season parameters extraction. 

 Some debug solution for TIMESAT in case of installation problem on some computer 

 

http://www.vito-eodata.be/
http://free.vgt.vito.be/
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2 General methodology of the Crop Yield 
Forecasting 

The basis of the proposed CYF model is simple and consists in studying the correlation 

between historical yields of a given crop and selected explanatory variables. The most 

correlated variables will then be used as predictive variables for yield of the current year.   

These explanatory variables are of 3 types: 

 Meteorological: cumuli of meteorological parameters (rain, evapotranspiration, solar 

radiation,…) 

 Agrometeorological: outputs of AgrometShell software 

 Computed from remote sensed NDVI : phenological (season) parameters computed 

by TIMESAT and cumuli of NDVI values on identified phenological periods 

The development of this multivariate model can be divided in 3 main parts (Figure 1 and 

Figure 2): 

 The identification of quantitative variables correlated with crop yields (Inputs) 

 The production of explanatory variables 

 The statistical study of the correlation between the generated explanatory variables 

and the historical yields. 

This manual focuses on the production of the Remote Sensed NDVI derived explanatory 

variables only. 
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Figure 1 : General methodology of the Crop Yield Forecasting. Surrounded in red: the Remote 
Sensing part of the methodology. In blue, the main methodology updates. 

 

 

Figure 2: the 3 main steps of the Crop Yield Forecasting Methodology 
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CHAPTER I. DATABASE PRODUCTION 

This first chapter describes in details the whole process to produce NDVI derived 

explanatory variables, from software download to variables verification. Software, NDVI 

images, and methodology are presented, and each parameter value is justified.  

Once the detailed methodology is understood and mastered by the operator, process 

automation, by the use of batch files, has to be envisaged in order to reduce considerably 

the time used to produce the RS derived database.  

Typically, this first chapter will be useful when producing the database for the first time and 

to understand deeply the methodology. 

3 General methodology of the RS part of 
the CYFS 

The general methodology of the RS part of the CYFS can be divided in 5 parts according to 

the working environment (purple boxes) of each step, as illustrated at the Figure 3: 

1. Download of the NDVI images from the web 

2. Extraction of the NDVI images in the desired format and area (Tajikistan extent)  

o With VGT Extract software for SPOT VEGETATION images 

o With PPT for PROBA-V images 

3. Temporal smoothing of the NDVI images series and season parameters extraction 

with TIMESAT 

4. Computation of variables statistics per provinces, time step (year / decade) and 

crops with WinDisp 

5. Computation of additional variables (cumulated NDVI per phenological period) with 

Excel 
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Figure 3: general methodology of the Remote Sensing part of the CYFS 
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4 Check list for NDVI images process 

Below is the list of all the steps to follow for the preparation of the remote sensing 

explanatory variables for the CYF model. Each data production step has to be followed by a 

careful data check. 

Ensure to have the correct computer directories organisation on your 

computer (page 23) 

Ensure to have the necessary software (page 26) 

 VGT Extract 2.1.0. or newer version 

 PROBA-V ProductCustomization Tool” (PPT) 1.2.1 or newer version 

 FWTools 2.4.7 that uses GDAL library. 

 7-zip 

 TIMESAT 3.1.1. 

 WinDisp 5.1 

 Microsoft Office Excel 

 Notepad++ 

 QuantumGIS or ArcGIS (optional) 

NDVI images preparation (section 8, page34) 

 Download all available NDVI images (SPOT VEGETATION and PROBA-V) from internet 

and stored them in right directory 

 Extract NDVI images (extraction = unzip, spatial subset, format conversion) with  

o “VGT Extract” software for SPOT VEGETATION NDVI images 

o “PPT” software for PROBA-V NDVI images, with the batch file 

“ProductCustomization_batch.bat.” 

 Complete the current year image database with the “historical mean” NDVI images 

(confer page 158). If the “historical mean” NDVI images time-series is not available, 

you will have to compute it as indicated in the section “Operations for real-time CYF” 

below, after the complete process has been executed once, and then restart the 

complete process for the current year. 
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TIMESAT process (page 69) 

 Establish the right settings for NDVI smoothing and seasons parameters computation 

with TSM_GUI 

 Make settings files, 1 per year and sensor (to be used in the “TSF_process”) 

 Make list files, 1 per year and sensor (to be used in the “TSF_process”) 

 Create and execute batch files for  

o “TSF_process”: produces the “.tpa” and “.tts” files (approximately 30 minutes 

per year for Tajikistan) 

o “TSF_fit2img”: produces the smoothed NDVI images 

o “TSF_seas2img”: produces the season parameter images 

 Delete useless smoothed NDVI images produced by “TSF_fit2img” process (images of 

the decades 1 to 36 and 73 to 108 of each year) (with the batch file “...\DATA\NDVI 

IMAGES\RESULTS\BATCH_DELETE_SUPERFLUOUS_FITTED_IMAGES.bat”) 

WinDisp process (page 105) 

 Ensure to have necessary boundary files in “.bna” format for the crop of interest: 

wheat, potato, cotton,... These files have to respect the recommendations given in 

section 11.4 at page 136. 

 Create list files 

o 1 list file per year (17 years in 2015) and sensor, listing all smoothed NDVI 

images in the year (36 decades in a year) 

o 1 list file per season parameter images (11 season parameters) and sensor, 

listing images of all years of a given season parameter 

 Create and execute batch files for: 

o Importing images and modifying image headers 

o Computing spatial statistics 

Operations for real-time CYF (page 158) 

 Create an “historical mean” SPOT VEGETATION NDVI images time-series (confer page 

159) with the batch file “...\DATA\WINDISP DATA\BATCH 

FILES\MEAN_YEAR_1999_2013_SPOT_VGT.cmd” 

 Convert the “historical mean” SPOT VEGETATION NDVI images time-series from “IDA” 

format to “ENVI-standard” format with the batch file “...\DATA\NDVI 

IMAGES\WINDISP\MEAN_1999_2013_SPOT_VGT\BATCH_FORMAT_CONVERSION_M

EAN_1999_2013_SPOT_VGT.bat” 
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 Complete the current year image database with the “historical mean” NDVI images 

(confer page 158).  

 Restart the complete process for the current year time-series completed with the 

“historical mean” time-series 

Post processings (optional) (in Excel or programming software) (pages 156 

and 163) 

 Select right explanatory variables (section 12.2, page 163) (for real time CYF) 

 Compute NDVI cumuli on defined periods (phenological periods or others) (page 156) 

 Compute additional phenology parameters (section 12.2, page 163) 
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5 Overview of the variables to compute 

NDVI-derived explanatory variables to produce are numerous and of 2 types:  

 NDVI values, mainly cumulated NDVI values on identified periods 

 Season parameters, related to crop phenology 

Here is an overview of the potential number of NDVI-derived explanatory variables to 

produce in the case of Tajikistan for 2015.  

List of parameters defining the number of explanatory variables 

 17 years. Years: 1999 – 2015 = (1999 is the start of SPOT VEGETATION NDVI images 

series) 

 36 decades per year 

 3 Crops. Currently, crop yield forecast in Tajikistan is done for: 

o Winter wheat 

o Potato 

o Cotton 

 4 Provinces. Tajikistan is composed of 4 provinces. 

 11 season parameters: season parameters computed in TIMESAT. However, 

depending on the forecast date, not all parameters are usable (confer section 12.2, 

page 163).  

 2 sensors. SPOT VEGETATION [1999-2013] and PROBA-V [2014-...]. 

Number of true NDVI variables 

The mean NDVI value is computed per year, decade, crop and Province, which totals up: 

 17 years * 36 decades * 3 crops * 4 provinces = 7 344 NDVI values distributed into 51 Excel 

files (1 Excel file summarize NDVI values for all decades and provinces).  

In addition, cumulated NDVI variables on identified phenological periods have to be added 

to this. 

Number of season parameters 

The 11 season parameters are computed per year, crop and province, which total up: 

11 season parameters * 17 years * 3 crops * 4 provinces = 2 244 season values distributed 

into 33 Excel files (1 Excel file summarize season parameters for all years and provinces).  

In addition some complementary season parameters can be computed later in programming 

software as described in section 12.2, page 163). 
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6 Computer directories organisation 

Figure 4 presents the directory organisation for the database of the remote sensing part of 

the CYFS. It is recommended to the user to respect this directory organisation as this 

manual often refers to particular directory and that the proper functioning of many 

furnished process (especially the batch files and the TIMESAT and WinDisp dependent files) 

depends on that directory organisation.  

 

 

Figure 4: Directory organization for the database of the remote sensing part of the CYFS 

The complete directory used when producing the training data was “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\ TAJIKISTAN_CYFS_RS_2015\...”. It is recommended to the user 

to place the training package “TAJIKISTAN_CYFS_RS_2015” in the same directory. 

However, if the user places the training package in another directory, he will have to modify 

accordingly the files referring to this directory, mainly list files and batch files.  
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In this manual the directories will be abbreviated, omitting the “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\ TAJIKISTAN_CYFS_RS_2015\...” part that will be replace by “...”, 

e.g. “...\DATA\NDVI IMAGES\RESULTS\”. (Note that “space” or “blank” in directory names 

may sometimes lead to some problem on some “unstable” computers when using or 

building list files or batch files with some programs... in case of problem when working with 

list and batch files on your computer, you may investigate this potential source of problem.) 

All the data mentioned in this manual are available in the training package in the “...\DATA” 

folder. In particular, the images for each processing level are given in the “NDVI IMAGES” 

folder which is described in the Figure 5 below. 

 

 “...\DATA\NDVI IMAGES\PROBAV\” contains: 

 The PROBA-V images as downloaded from the website http://www.vito-eodata.be/ 

for the period [2014 – January 2015] for the 2 tiles X24Y03 and X25Y03 (PPT_IN 

folder) 

 The PROBA-V images on TAJIKISTAN extent, in ENVI format (“.img” image files with 

“.hdr” header files), 1 image per decade (2 tiles mosaicked), (extracted with PPT 

software) (PPT_OUT folder) 

 The batch file “ProductCustomization_batch.bat” for the spatial subsetting, 

mosaicking and format conversion of the PROBA-V images. 

“...\DATA\NDVI IMAGES\SPOT_VGT\” contains: 

 The SPOT VEGETATION images on WEST ASIA extent as downloaded from the 

website http://www.vito-eodata.be/ for 3 sample images (folder 

“SPOT_VGT_WEST_ASIA”) 

 The SPOT VEGETATION images for the period [1999 – 2013], on TAJIKISTAN extent, in 

ENVI format (“.img” image files with “.hdr” header files) (extracted with “VGT 

EXTRACT” software) (folder “EXTRACTED_SPOT_VGT_TAJIKISTAN”) 

 The “MEAN_1999_2013_ENVI_FORMAT” folder contains the historical mean time-

series in ENVI standard format.  

“...\DATA\NDVI IMAGES\METOP_AVHRR\” contains: 

 The METOP AVHRR images on WEST ASIA extent as downloaded from the website 

http://www.vito-eodata.be/ for 3 sample images (folder 

“METOP_WEST_ASIA_DOWNLOADED”) 

 The METOP AVHRR sample images, on TAJIKISTAN extent, in ENVI format (“.img” 

image files with “.hdr” header files) (extracted with “7ZIP” and “FWTools” software) 

(folder “METOP_TAJIKISTAN_SUBSET”)  

“...\DATA\NDVI IMAGES\RESULTS\” contains: 

http://www.vito-eodata.be/
http://www.vito-eodata.be/
http://www.vito-eodata.be/
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 The list files, settings files and batch files necessary for TIMESAT processes.  

 The TIMESAT outputs from the 3 processes “TSF_process” (“.tpa” and “.tts” files), 

“TSF_fit2img” (smoothed NDVI images) and “TSF_seas2img” (season parameters 

images) 

“...\DATA\NDVI IMAGES\WINDISP\” contains: 

 The smoothed NDVI images and season parameter images in correct WinDisp format 

 The folder “MEAN_1999_2013_SPOT_VGT” contains the historical mean time-series 

of SPOT VEGETATION in WinDisp format 

Figure 5: Description of the content of the “…\DATA\NDVI IMAGES\” directory 
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7 Presentation of the main software 

5 main specialized software are used in the Remote Sensing part of the CYF system: 

 VGT Extract 2.1.0. 

 PROBA-V ProductCustomization Tool (PPT) 1.2.1. 

 FWTools 2.4.7 that uses GDAL library. 

 TIMESAT 3.1.1. 

 WinDisp 5.1 

All software and user guides are provided in the training package. 

7.1 VGT EXTRACT 2.1.0 (for SPOT VEGETATION) 

(Source: VGT EXTRACT Software User Guide (VGTExtract_SUG_EN, 2010-12-16)) 

The primary aim of VGTExtract is to facilitate the integration of SPOT-VEGETATION products 

(VGT) into commonly used end-user software, such as GIS and Remote Sensing software for 

further analysis & post-processing, or visualization software. These products are distributed 

by VITO and its partners under license from CNES and SPOT IMAGE (for basic products like 

NDVI) […].  

VGT products are usually distributed in the form of zipped archives that consist of one or 

more data files in HDF (4 or 5) file format, […] 

VGTExtract can automatically perform the following actions on the zipped archives data files: 

 Unpack (uncompress) the product 

 Extract a given geographic bounding box or Region of Interest (ROI);  

 Convert to other file formats;  

 Change data type as may be required by the output format;  

 Apply a linear encoding of the form output = (scale * input) + offset) to all values 

except one (and only one) special value for missing data.  

Availability: VGT Exctract can be downloaded for free from the “Free VEGETATION 

distribution site” at the following address: http://free.vgt.vito.be/. It is advised to download 

the following version: “For Windows: VGTExtract version with the Java virtual machine”. The 

VGT EXTRACT Software User Guide can be downloaded at the following address: 

http://www.vgt4africa.org/VGTExtract.do. 

http://free.vgt.vito.be/
http://www.vgt4africa.org/VGTExtract/Windows/VM/setupVGTExtract_VM.exe
http://www.vgt4africa.org/VGTExtract.do
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Installation: once downloaded, the installation of VGT EXTRACT is made by execution of the 

setup “setupVGTExtract_VM.exe“. More information on the installation procedure can be 

found in the VGT EXTRACT Software User Guide. Update of VGT EXTRACT from an old 

version to the newest version under Windows7 may result in bug when using VGT EXTRACT 

as explained in the “VGT Extract Software User Guide” in section “2.2 Upgrading to a new 

version”.  This may be due to the previous settings of VGT EXTRACT that are not suppressed 

when uninstalling an old version. In that case, to bypass this problem, install VGT Extract in 

another directory than the one of the previous version (the default directory is “C:\Program 

Files (x86)”), e.g. “C:\VGTEXTRACT”. 

7.2 PROBA-V ProductCustomization Tool (PPT) 
1.2.1. 

 (Source: http://www.vito-eodata.be/PDF/image/news/PROBA-V_Product_Customization_Tool.html)  

For PROBA-V, a “PROBA-V ProductCustomization Tool” (PPT) is available. The PPT software 

facilitates the use of PROBA-V products by providing following customization operations: 

 File format conversion (ENVI - HDF5 - HDF4 - GEOTIFF) 

 Map projections  

 Mosaicking 

 Band extraction 

 Clipping 

The PPT software is compiled for use on multiple operating systems (Unix and Windows) and 

in 32 and 64 bit.  

Availability: PPT can be downloaded for free at the following address: http://www.vito-

eodata.be/PDF/image/news/PROBA-V_Product_Customization_Tool.html) 

http://free.vgt.vito.be/ or from the upper right corner of website http://www.vito-eodata.be/ 

(Figure 6). Download the version compatible with your computer and the release notes.  

http://www.vito-eodata.be/PDF/image/news/PROBA-V_Product_Customization_Tool.html
http://www.vito-eodata.be/PDF/image/news/PROBA-V_Product_Customization_Tool.html
http://www.vito-eodata.be/PDF/image/news/PROBA-V_Product_Customization_Tool.html
http://free.vgt.vito.be/
http://www.vito-eodata.be/


28 

 

 

Figure 6: Access to “PROBA-V ProductCustomization Tool” from http://www.vito-
eodata.be/ 

Once downloaded, you will find the “UserManual.pdf” of the PPT in the folder 

“…\SOFTWARE\PPT\probav_ppt_v1.2.1_windows64\probav_ppt_v1.2.1_windows64\doc\”. 

This manual has the following sections: 

 Tool Capabilities 

 Tool Installation 

 Tool Command-Line Interface  

 Tool Graphical User Interface 

Installation: 

In the PPT user manual, the section “PROBA-V ProductCustomization Tool Installation” will 

indicate you how to install the PPT. 

Here are some explanations to simplify and clarify the one of the user manual: 

 Unzip the zip folder “probav_ppt_v1.2.1_windows64.zip” to get the folder 

“probav_ppt_v1.2.1_windows64” 

 Create a “PPT” directory on the C (for example) disc of your computer as: “C:\PPT” 

 Copy the “bin, doc, etc, gui, lib” folders of the “probav_ppt_v1.2.1_windows64” 

folder into “C:\PPT” 

 Create and modify environment variables of your computer for PPT: follow the 

instructions on page 17 section 2 (“Installation Instructions for Windows Platforms”) 

of the user manual. 

http://www.vito-eodata.be/
http://www.vito-eodata.be/
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 Don’t use command line to set the PATH environment variable but rather do it 

directly through “Advanced System Settings” panel (i.e. Start – Control Panel – 

System – Advanced System Settings - environment variables). 

 In the “system variable” panel, create a new environment variable called 

PPT_INSTALL_DIR by clicking the “New” – button. The value of the variable should 

hold the full path to where the PPT – tool has been installed (e.g. “C:\PPT”). 

 In the “system variable” panel, edit the “PATH” variable (Figure 7) by selecting the 

“PATH” (case insensitive) variable in the “Environment Variables” panel, click the 

“Edit” button and append the following paths to the to the variable values, separated 

by a “;” character:  

o C:\PPT\bin 

o C:\PPT \lib 

 It is strongly advised to user to update you Java Runtime Environment (JVE) as 

indicated in the PPT user manual for the PPT GUI to work properly. Download the JVE 

appropriated for your computer at the following address: 

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-

2133151.html. And install it.  

 

Figure 7: Installation of PPT: editing the “PATH” environment variable  

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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7.3 FWTools 2.4.7 (for METOP AVHRR) 

FWTools is a set of Open Source GIS binaries for Windows (win32) and Linux (x86 32bit) 

systems produced by Frank Warmerdam (ie. FW) (Source: http://fwtools.maptools.org/). It 

includes, among other, the GDAL library, needed for this methodology. FWTools is used in 

order to facilitate the call of GDAL library from DOS command line. 

GDAL is a translator library for raster geospatial data formats. As a library, it presents a 

single abstract data model to the calling application for all supported formats. (Source: GDAL 

website http://www.gdal.org/) 

In this case, GDAL is used to clip (subset / window) METOP AVHRR NDVI images on Tajikistan 

extent and to convert images format.  

Availability: FWTools can be downloaded for free from http://fwtools.maptools.org/.  

Installation and use: confer section 8.5.3.3 at page 56. 

7.4 TIMESAT 3.1.1. 

(Source: TIMESAT website http://www.nateko.lu.se/timesat/timesat.asp)  

TIMESAT is a software package for analysing time-series of satellite sensor data, typically 

time series of NDVI images. 

Output from the program is a set of files containing seasonality parameters (beginning of 

season, end of season, amplitude, integrated values, derivatives, etc.), as well as fitted 

(temporally smoothed) function files containing smooth renditions of the original data.  

TIMESAT operates in 3 steps: 

 Definition of the number of seasons and their approximate timing 

 Fitting of smoothing functions to the data (Savitzky-Golay filter, or least-squares 

fitted assymetric Gaussian or double logistic smoothing functions).  

 Computation of the seasonality parameters 

TIMESAT runs from a graphical user interface. For large images or long time-series FORTRAN 

executables ensure fast processing. Matlab is the default running environment but is no 

longer required. 

Availability: downloadable for free, for non-commercial academic research (see distribution 

policy), after registration, at: http://www.nateko.lu.se/timesat/timesat.asp?cat=4. Note that 

http://fwtools.maptools.org/
http://www.gdal.org/gdal_datamodel.html
http://www.gdal.org/
http://fwtools.maptools.org/
http://www.nateko.lu.se/timesat/timesat.asp
http://www.nateko.lu.se/timesat/timesat.asp?cat=4
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the retrieval of the login that will give you access to the download can take several days. For 

detailed information confer section 10.1. 

Installation: for information on the installation refer to section 10.2 of this manual and to 

pages 36 and 37 (section 7) of “TIMESAT 3.1 Software Manual” that comes with the 

download. In this case, unzip TIMESAT zipped folder into “...\SOFTWARE\TIMESAT\” 

directory. 

TIMESAT may sometimes not install properly on some computers. Here are some tips to 

debug TIMESAT. 

 Some installation file of TIMESAT may be blocked by some antivirus (AVAST,...) when 

copying the TIMESAT files to computer or during installation. In this case, deactivate 

the antivirus temporally while needed (copying and installation of TIMESAT). Don’t 

forget to reactivate it after! 

 Be sure to have installed the “Microsoft Visual C++ 2010 Redistributable Package” or 

newer version, version adapted to your computer. This is available through Google 

search. This should normally be installed when installing the TIMESAT 

“MCRinstaller.exe”  

 A problem that can arise with TIMESAT installation is the following. The 

“MCRInstaller.exe” installation can install successfully, but when launching 

“TIMESAT.exe”, nothing happen except a DOS window that opens and closes quickly. 

When launching the “TIMESAT.exe” through command lines interface, the following 

error message appears: “Could not access the MCR component cache” (Figure 8). 

 

Figure 8: TIMESAT error 

This indicates a problem with the “MCR component cache”, which is a folder that is 

created when installing “MCRInstaller.exe” and launching “TIMESAT.exe”. For 

unknown reason this “MCR component cache” seems to be corrupted. 

This “MCR component cache” is located in a directory like: 

“C:\Users\username\AppData\Local\Temp\username\ mcrCache7.14”. 

A solution to this problem can be: 

o Go to the directory “C:\Users\username\AppData\Local\Temp\username\ 

mcrCache7.14”. 
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o Simply give a new name to the “mcrCache7.14” folder like 

“old_mcrCache7.14” 

o Launch “TIMESAT.exe” by clicking on it (in the folder 

“…\SOFTWARE\TIMESAT\timesat311_standalone_windows32\timesat311\co

mpiled\Win32”) 

o This will recreate automatically the good “mcrCache7.14” folder in the 

directory “C:\Users\username\AppData\Local\Temp\username\ 

mcrCache7.14”. 

o TIMESAT should now open normally. 

7.5 WinDisp 5.1 

WinDisp is a public domain, easy to use software package for the display and analysis of 

satellite images, maps and associated databases, with an emphasis on early warning for 

food security. WinDisp was originally developed for the FAO Global Information and Early 

Warning System. It allows users to: 

 Display and analyse satellite images 

 Compare two images and analyse trends in a time-series of images 

 Extract and graph trends from a number of satellite images such as during the 

growing season for comparison with other years 

 Compute new images from a series of images 

 Display tabular data in map format 

 Build custom products combining images, maps and specialised legends 

 Write and execute batch files to automate routine and tedious tasks 

 Build a customized project interface for providing users with detailed menus of 

available data for a country or a specific area 

Availability: WinDisp can be downloaded for free at the following address: 

http://www.fao.org/giews/english/windisp/windisp.htm. 

Installation: once downloaded, the installation of WinDisp is made by execution of the setup 

“windisp51_setup.exe “. More information on the installation procedure can be found in the 

WinDisp Software User Guide. 

http://www.fao.org/giews/default.htm
http://www.fao.org/giews/default.htm
http://www.fao.org/giews/english/windisp/windisp.htm
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Important remarques 

1. Note that this manual don’t describe thoroughly all the software used but rather 

presents only the functions of the software that are of interest for the training in crop 

yield forecasting.  

For more information on the software, refer to the user guides provided with them. 

2. Before manipulating data (especially in WinDisp) beware of having proper computer 

settings. For proper use (at least with WinDisp) the decimal separator of the 

computer has to be the point and not the coma! 
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8 NDVI images: database creation  

8.1 NDVI concept and NDVI images 

NDVI stands for Normalized Difference Vegetation Index. It is a spectral index particularly 

appropriate for the study of vegetation. It combines radiation in the Red and Near Infra Red 

(NIR) spectral region (Figure 9) according to the following formula: 

)(

)(

REDNIR

REDNIR
NDVI




  

Where:  

 NIR is the Near Infra Red spectral region: 0,79 - 0,89 µm 

 RED is the Red spectral region: 0,61 - 0,68 µm 

Figure 9: electromagnetic spectrum and spectral region 

Generally (Figure 10) 

 Dense vegetation in good phytosanitary condition will absorb a lot the 

electromagnetic spectrum in the RED spectral region. This results in a HIGH NDVI 

value. 

 Sparse vegetation and/or in bad phytosanitary condition will not absorb a lot the 

electromagnetic spectrum in the RED spectral region. This results in LOW NDVI value. 
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Figure 10: reflection of the NIR and visible part of the electromagnetic spectrum by green-
healthy and brown-sick plants. 

RED and NIR radiation information are collected everyday all over the world thanks to a 

series of sensors disposed on satellites. This spectral information is then used to compute 

NDVI images (Figure 1 and Figure 16) which are then distributed through internet. This index 

is then used for the assessment of the vegetation status all over the world. Well-known 

examples of NDVI application are: 

 The monitoring of crops evolution during the cropping season 

 The monitoring of the green vegetation evolution in the Sahel region 
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8.2 NDVI images encoding 

In NDVI satellite images, NDVI values, i.e. the Physical Value (PV) of the NDVI indicator, vary 

between [0-1] and are associated to the image pixels under the form of a numeric value 

often called “Digital Number” (DN). The value of the DN is often proportional to the NDVI 

through a linear mathematic relation of type “PV(NDVI) = SCALE * DN + OFFSET” where the 

“SCALE” parameter is the slope of the straight line linking NDVI and DN, and the “OFFSET” is 

the intercept of this line with the NDVI axis when DN is equal to 0 (Figure 11). In an image 

coded with 8 bit, there are 28 i.e. 256 possible values for each pixel, comprised in the interval 

[0-255]. 

Figure 11: Relation between NDVI and DN for PROBA-V 
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8.3 SPOT VEGETATION, METOP AVHRR and 
PROBA-V sensors and NDVI images 
presentation and comparison 

The method presented in this manual proposes to use only NDVI products coming from 2 

sensors: 

 SPOT VEGETATION for the period [1999 - 2013] 

 PROBA-V for the period [2014 - ...] 

Nevertheless another sensor produces very similar NDVI products: 

 METOP AVHRR for the period [2008 - ...] 

So, in addition to describe the method for SPOT VEGETATION and PROBA-V, this manual will 

also, most of the time, for information, describe it for METOP AVHRR NDVI products. It is 

advised to the user to focus on SPOT VEGETATION and PROBA-V only.  

Figure 12 presents an artist’s impression of these 3 satellites and Figure 13 their timeline.  

   

Figure 12: Artist’s impression of the 3 satellites SPOT VEGETATION, METOP AVHRR and 
PROBA-V 
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Figure 13: Timeline of three sensors SPOT VEGETATION, Metop AVHRR and PROBA-V and 
their use in the CYFS. 

SPOT VEGETATION, METOP AVHRR and PROBA-V NDVI images are really similar on a 

technical point of view, which should allow using METOP AVHRR and PROBA-V images in the 

continuity of the SPOT VEGETATION series that provided its last complete year of images in 

end of 2013. For more information on the compatibility of these 3 sensor’s series, confer 

section 11.3.3.2** Explanation of “Slope” and “Intercept” parameters values., page 126. 

Note also that other NDVI products coming from other sensors exist. The most widely 

distributed is probably the one coming from the Advanced Very High Resolution Radiometer 

(AVHRR) sensor on the National Oceanic and Atmospheric Administration (NOAA) satellite 

(http://phenology.cr.usgs.gov/ndvi_avhrr.php).   

Table 1 presents a comparison on the main technical features of these 3 sensor’s images 

when downloaded from PDP. Examples of NDVI S10 images for West-Asia and Tajikistan 

extents are given in Figure 15 and Figure 16 respectively. 

Satellite common name SPOT VEGETATION Metop AVHRR PROBA-V 

Satellite platform 
SPOT 4 
SPOT 5 

Metop PROBA-1 

Instrument sensor 
VEGETATION 1 
VEGETATION 2 

AVHRR VEGETATION 

Spectral bands BLUE, RED, NIR, SWIR 
RED, NIR, SWIR, TIR1, 

TIR2 
BLUE, RED, NIR, SWIR 

Spatial resolution 1 km 1 km 1 Km 

Temporal resolution 1 day 1 day 1 day 

Decadal synthesis process MVC* MVC* MVC* 

Number of S10 images per year 36 36 36 

Period of availability 
1st April 1998 to 31st 

May 2014 
11th March 2007 to... 

21st November 2013 
to... 

http://phenology.cr.usgs.gov/ndvi_avhrr.php


39 

 

Years of complete availability in 
early 2015 

15 years 
[1999 – 2013] 

7 years 
[2008 – 2022] 

1 year 
[2014 – ...] 

Number of useful images for the 
period [1/1/1999 – 31/12/2014] 

540 252 36 

Size of 1 NDVI product at download 
extent 

~21 Mo ~40 Mo 
~1.36 Mo for the 2 

tiles 

Size of 1 NDVI product on Tajikistan 
extent 

437 Ko 437 Ko 437 Ko 

Size of useful images time series for 
the period [1/1/1999 – 31/12/2014] 
(NDVI products) at download extent 

~12 GO 
(West-Asia extent) 

~10 GO 
(West-Asia extent) 

~ 50 Mo  
(for the 2 tiles) 

Size of useful images time series for 
the period [1/1/1999 – 31/12/2014] 
(NDVi products) on Tajikistan extent 

234 Mo 110 Mo 16 Mo 

Real time acquisition? Time series finished Yes Yes  

Real time access? ** / Yes** Yes 

Real time price? / Free Free 

Delivery package ZIP folder ZIP folder Simple folder 

Data type 
8-bit 

unsigned integer 
8-bit 

unsigned byte 
8-bit 

unsigned integer  

Image format 
HDF 

(.HDF) 
flat binary***  

(.IMG) 
HDF5 

(.HDF5) 

Download extent West-Asia West-Asia Tiles X24Y03, X25Y03 

Download extent coordinates 
(North, South, West, East) (Degree) 

50, 5, 25, 98 50, 5, 25, 98 45, 35, 60, 80 
(Edges of the 2 tiles) Coordinates of the centre of the edge pixels 

N° of rows 5041**** 5040 1120 for each tile 

N° of columns 8177**** 8176 1120 for each tile 

Pixel spatial resolution (degree) 
0.0089285714 0.0089285714 0.0089285714 

= 1°/112 = ± 1 km along the great circle 

Valid data 
range 

Valid DN range 
Flags value(s) 
Flag for aberrant states 
(Sea, NoData, 
NoValidData, Error) 

[1-255] 
0 
/ 

[0-250] 
[251-254] 

255 

[0-254] 
255 

Formula linking DN and NDVI 
NDVI = - 0.1 + 0.004 

* DN 
NDVI = - 0.08 + 0.004 

* DN 
NDVI = - 0.08 + 0.004 

* DN 

Coordinate system 
Geographic latitude 

longitude 
Geographic latitude 

longitude 
Geographic latitude 

longitude 

Cost  Free  Free  Free  

Table 1 :  SPOT VEGETATION, METOP AVHRR and PROBA-V NDVI images features for the 
downloaded images extent used for Tajikistan 
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* Maximum Value Compositing 

MVC stands for “Maximum Value Compositing”. This is the name of the algorithm that is 

used for the production of the 10 days NDVI synthesis from daily NDVI images. This process 

merge segments (data strips) acquired in a ten days period. All the segments of this period 

are compared again pixel by pixel to pick out the 'best' ground reflectance values. The “best” 

reflectance is computed by the MVC process which consists in retaining the highest 

reflectance. 

** Near-real time acquisition 

To get near-real time METOP AVHRR images, send an e-mail to the Metop helpdesk as 

indicated on the METOP website http://www.metops10.vito.be/metop-

S10_pages/main.html#distribution.  

*** “Flat binary” format  

The images are distributed in “flat binary” format without header/trailer bytes. “Flat” 

means that each layer of a certain composite is stored in a separate image file. These files 

have the fixed extension *.IMG. All layers have the byte data type (1 pixel = 1 byte).  

Associated to each image file is a small ASCII-formatted annotation file (“header file”, which 

has the same base name as the image but extension *.HDR. It provides all the basic ancillary 

information to import the imagery directly into the ENVI software. When having the image 

and its header file in a same directory, the image can be opened easily in ENVI software. 

Figure 14 is an example of the header file of the NDVI image of West Asia window extracted 

from the MA10 of the second decade of December 2008. The sequence “1.5, 1.5, 25.0, 50.0” 

in “map info” specifies that the centre of the top-left pixel (Col=1.5, Rec=1.5) is located at 

the geographical position with Lon=25°, Lat=50°. 

 

Figure 14: METOP AVHRR NDVI WEST ASIA image header file content 

mailto:helpdesk@metopS10.vito.be
http://www.metops10.vito.be/metop-S10_pages/main.html#distribution
http://www.metops10.vito.be/metop-S10_pages/main.html#distribution
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**** Image size 

SPOT VEGETATION images are 1 pixel bigger than METOP AVHRR images on WEST-ASIA 

extent in longitude and latitude. SPOT VEGETATION images extend one column further to 

the East and one line further to the South compared to METOP AVHRR images. 

8.3.1 NDVI products online resources 

8.3.1.1 SPOT VEGETATION online resources  

Main website http://www.spot-vegetation.com/index.html 

FAQ http://www.spot-vegetation.com/faqnew/index.html 

Product metadata http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=0ce4e2fe-

183f-4c04-928c-e1f770fa5b34 

8.3.1.2 METOP AVHRR online ressources  

Main website http://www.metops10.vito.be/index.html 

FAQ http://www.metops10.vito.be/metop-S10_pages/FAQ.html 

Product metadata http://www.vito-eodata.be/collections/srv/eng/main.home?any=95c6d610-

ba36-11de-8a39-0800200c9a66  

8.3.1.3 PROBA-V online ressources 

Main website http://proba-v.vgt.vito.be/ 

FAQ http://www.vito-eodata.be/PDF/image/faq_help/Faq.html 

Product metadata http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=2dc3d0e3-

a731-11e2-9e96-0800200c9a66  

User manual http://www.vito-eodata.be/PDF/image/PROBAV-

Products_User_Manual_v1.1.pdf 

PROBA-V on ESA 

website 

https://earth.esa.int/web/guest/data-access/browse-data-products/-

/asset_publisher/y8Qb/content/proba-v-1km-synthesis-products-s1-toa-s1-

toc-and-s10-toc  

https://earth.esa.int/web/guest/missions/esa-operational-eo-

missions/proba-v 

http://www.spot-vegetation.com/index.html
http://www.spot-vegetation.com/faqnew/index.html
http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=0ce4e2fe-183f-4c04-928c-e1f770fa5b34
http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=0ce4e2fe-183f-4c04-928c-e1f770fa5b34
http://www.metops10.vito.be/index.html
http://www.metops10.vito.be/metop-S10_pages/FAQ.html
http://www.vito-eodata.be/collections/srv/eng/main.home?any=95c6d610-ba36-11de-8a39-0800200c9a66
http://www.vito-eodata.be/collections/srv/eng/main.home?any=95c6d610-ba36-11de-8a39-0800200c9a66
http://proba-v.vgt.vito.be/
http://www.vito-eodata.be/PDF/image/faq_help/Faq.html
http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=2dc3d0e3-a731-11e2-9e96-0800200c9a66
http://www.vito-eodata.be/collections/srv/eng/main.home?uuid=2dc3d0e3-a731-11e2-9e96-0800200c9a66
http://www.vito-eodata.be/PDF/image/PROBAV-Products_User_Manual_v1.1.pdf
http://www.vito-eodata.be/PDF/image/PROBAV-Products_User_Manual_v1.1.pdf
https://earth.esa.int/web/guest/data-access/browse-data-products/-/asset_publisher/y8Qb/content/proba-v-1km-synthesis-products-s1-toa-s1-toc-and-s10-toc
https://earth.esa.int/web/guest/data-access/browse-data-products/-/asset_publisher/y8Qb/content/proba-v-1km-synthesis-products-s1-toa-s1-toc-and-s10-toc
https://earth.esa.int/web/guest/data-access/browse-data-products/-/asset_publisher/y8Qb/content/proba-v-1km-synthesis-products-s1-toa-s1-toc-and-s10-toc
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba-v
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba-v
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Figure 15 and Figure 16 present SPOT VEGETATION NDVI S10 image for West-Asia and 

Tajikistan extent respectively (1st decade of May 1999).  

 

Figure 15: SPOT VEGETATION NDVI S10 image for West-Asia (1
st

 decade of May 1999). 
Tajikistan boundaries appear in black. 

 

Figure 16 : SPOT VEGETATION NDVI S10 image for TAJIKISTAN (1
st

 decade of May 1999). 
Tajikistan provinces boundaries appear in red. 
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8.4 NDVI images access and download 

The S10 NDVI images for SPOT VEGETATION, METOP AVHRR and PROBA-V can all be 

downloaded for free on the VITO “Product Distribution Portal” (PDP) web page: 

http://www.vito-eodata.be/ (Figure 17). Some images have already been downloaded and 

are available in the training package under the directory “...\DATA\NDVI IMAGES\”. 

8.4.1 Registration and login for the PDP 

To be able to download the different products, you have to “register” and then “login” 

with the menus in the upper right corner of the PDP web page (arrow 1 in Figure 17).  

 

Figure 17: Home page of the Product Distribution Portal http://www.vito-eodata.be/ with the 
SPOT VEGETATION, METOP AVHRR and PROBA-V products of interest highlighted 

1. Register: 

o Click on the “register” button. 

o Complete the form (Figure 18) and write somewhere your login and 

password. 

o Accept the terms of use and privacy policy. 

o Click on register.  

http://www.vito-eodata.be/
http://www.vito-eodata.be/
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o You should soon receive an email. Go to your email box and click on the 

activation link in the email you received.  

2. Login: 

o Once activation is done, go back to the PDP. 

o Login (arrow 1 in Figure 17) with your user name and password. 

o Once your are “login”, there will be the message “Welcome First name Last 

name” appearing in the upper right corner of the (PDP) 

 

Figure 18: Registration form of the Product Distribution Portal http://www.vito-eodata.be/ 

A video explaining how to order and download images from the PDP is available in the upper 

right part of the PDP home page by clicking on link “View the PDF instruction movie” 

http://www.vito-eodata.be/PDF/image/movie/pdf_instruction_movie.html. Note that there 

have been some changes in the PDP since the video was made.  

8.4.2 Supplementary registration for PROBA-V NDVI  

VITO distributes the PROBA-V S10 TOC NDVI collection on behalf of ESA. Therefore you will 

need to apply for this data by a supplementary registration on Earthnet online 

https://earth.esa.int/web/guest/home.   

http://www.vito-eodata.be/
http://www.vito-eodata.be/PDF/image/movie/pdf_instruction_movie.html
https://earth.esa.int/web/guest/home
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A manual explaining “How to register for the PROBA-V 1km data?” is available here: 

http://www.vito-eodata.be/PDF/image/faq_help/Manual_PROBA-V1km_data.pdf.  

To have access to this new registration, follow the indications in the manual mentioned 

above or go directly to https://eo-sso-idp.eo.esa.int/idp/AuthnEngine and then follow the 

instructions of the manual. 

 In the subscription process to ESA you will need to give a project summary. You can use this 

(for the case of Tajikistan):  

Project: EU/FAO project “Support to Strengthening of the National Food Security 
Information System”. GCP/TAJ/007/EC PROJECT. 
Funding: EU FAO 
Objectives:  This project has been designed to strengthen the information system in 
Tajikistan. More specifically, the project will focus on ensuring that decision makers 
have access to the quality information required for designing, implementing and 
monitoring agricultural interventions to reduce poverty and malnutrition. In this 
respect, improving agro-meteorological information and crop forecasting is very 
important. 
PROBA V NDVI S10 images want to be used in a crop yield forecasting system in 
continuation of SPOT VEGETATION NDVI S10 images. 
Method: crop yield are forecasted by models using NDVI, meteo and agrometeo data, 
at regional scale, during the cropping season.  
Deliverable: no deliverable is foreseen for the time. The data will be used for the 
training only. 

 
After the subscription to ESA is complete, you should receive an email from “ESA Earth 

Observation Helpdesk” that informs you that you can now access to PROBA-V data. 

After you got the authorization from ESA, you should be able to download the PROBA-V 

images from the PDP (Figure 17) Erreur ! Référence de lien hypertexte non valide.by the 

process described below. 

http://www.vito-eodata.be/PDF/image/faq_help/Manual_PROBA-V1km_data.pdf
https://eo-sso-idp.eo.esa.int/idp/AuthnEngine
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8.4.3 Summary of NDVI products download 

Figure 19 present the summary of information on format, size, extent and processing tool for 

SPOT-VGT, METOP AVHRR and PROBA-V NDVI products after download, for Tajikistan. 

 Package Format Size (NDVI product) Extent Processing tool 

SPOT-

VGT 
 

ZIP folder .HDF 21 Mo West Asia VGT EXTRACT 

METOP 

AVHRR 
 

ZIP folder* .IMG 40 Mo West Asia 
7-ZIP and FWTools 

(GDAL library) 

PROBA-

V  

Simple folder .HDF5 1.4 Mo 
2 tiles X24Y03, 

X25Y03 
PPT 

Figure 19: Summary of format, size, extent and processing tool for SPOT-VGT, METOP AVHRR 
and PROBA-V NDVI products after download for Tajikistan 

* METOP AVHRR ZIP folder 

Each METOP AVHRR ZIP folder contains 26 files among which only the ones with the 

extension “…NDV.img” and “….NDV.hdr” are of interest for this application. These are the 

NDVI images on West-Asia extent and its header file in “ENVI” format. 
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8.4.4 NDVI images access, order and download 

Once registered and login on the http://www.vito-eodata.be/ website, to access, order and 

download the images, the process is similar for the 3 NDVI products (SPOT VEGETATION, 

(METOP AVHRR) or PROBA-V) with however some small difference for PROBA-V. Do the 

followings: 

1. Click on the icon of the PDP for the product you want to download (Figure 17) and 

this will drive you to the image catalog portal with a geographic interface. 

a. SPOT-VEGETATION: “SPOT-VEGETATION” window 

b. METOP AVHRR: “METOP-AVHRR S10 syntheses” window 

c. PROBA-V: “PROBA-V 1 KM SYNTHESES NEAR REAL-TIME” window. (No S10 

images are available in the module “PROBA-V TILES (OLDER THAN 1 

MONTH)”. 

Figure 20: search criteria settings in the geographic interface of the PDP. E.g. of SPOT 
VEGETATION. 

2. Select the desired product in the “Collection” menu: 

a. SPOT-VGT:   “S10 NDVI - continental extracts” 

b. METOP AVHRR:  “ENDVI10 products” 

c. PROBA-V:   “S10 TOC NDVI - 1 km” (TOC = Top Of Canopy =  

    atmospherically corrected) 

3. Select the period for which you want to download the data 

4. Indicate the desired extent 

a. Indicate the extent coordinates of the area of interest (ROI). The Tajikistan 

extent that will be considered in this manual is: North: 41.1, South: 36.6, 

West: 67.3, East: 75.2 (Figure 21).  

http://www.vito-eodata.be/
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b. Alternatively, in the geographic interface, you can interactively set to the 

region of interest. Countries’ borders don’t appear clearly in the current 

portal version. 

c. For SPOT VEGETATION and METOP AVHRR: 

i. SPOT VEGETATION and METOP AVHRR products are presented under 

the form of predefined ROI corresponding to continental extracts. In 

the case of Tajikistan, the zone “W-Asia” (West-Asia) has to be 

selected. The other two regions intersecting Tajikistan don’t cover it 

completely. 

ii.  Alternatively and in order to select only the images of “W-Asia, use 

an “extent” that is included only in the predefined ROI “W-Asia”, even 

if this extent is not in Tajikistan. This way, you will not have to select 

again between the different predefined ROI in the “Results” window 

(confer below). 

d. For PROBA-V: 

i. The PROBA-V products are not presented under the form of 

predefined ROI corresponding to continental extracts but rather on 

global extent that is organized under the form of tiles of 10° by 10°. 

ii. For PROBA-V you have to define the ROI “North: 41.1, South: 36.6, 

West: 67.3, East: 75.2”. This will enable the selection of the 2 tiles 

intersecting Tajikistan: X24Y03 and X25Y03.  

 

Figure 21: Tajikistan extent with extent borders coordinates in decimal degree. Background is 
the SPOT VEGETATION NDVI of 1st decade of June 1999. 
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5. Click on the “Search” button and this will drive you to the “Results” page of the PDP 

(Figure 22) with some information on the products: region, dates, size, Quicklook. 

Figure 22: Results interface of the PDP. E.g. of SPOT VEGETATION 

6. Select the desired products in the right panel.  

a. Select only the products that correspond to the desired extent.  

i. You can select the desired products manually in the list, or 

ii. You can select all products of a given ROI by selecting this ROI in the 

geographic interface. 

b. You can modify the number of products per page to display 

c.  (Note that it is possible to download directly the images one by one by 

clicking on the blue arrow. As this may take a long time for downloading a 

time series, you will not use this option. In order to fasten the process and to 

download group of images quickly, you can use a “ftp client” like “FileZilla”. 

Confer below). 

d. Don’t use the “select all n products” function. This function, in the current 

portal version, will result in very slow data preparation.  

7. Click on “Order now” button and this will drive you to the “Order follow-up” PDP 

page (Figure 23) that summaries your orders information and their status (“In 

production” or “Completed”, “Cancelled”, “Archived”, etc). (Don’t use the “Prepare 

Custom order…” option. This would cause the application not take into account the 

desired extent for PROBA-V and produce global data instead. This is probably a bug.) 
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Figure 23: “Order follow-up” page of the PDP. 

8. The preparation of your order, depending of its size, may take from a few seconds 

(e.g. 30 seconds for 36 images) to several tens of minutes. You can refresh the table 

with the double arrow button to update the production status. 

9. You can navigate through the different PDP windows with the upper right menu-

buttons . 

10. Once your order is “Completed”, you should receive an email in your email box with 

the name of the order, the order description, and the instructions to download it. 

One possibility to download the prepared images is to use a client FTP program like 

FileZilla. 

11. Download, install and configure FileZilla 

a. Download FileZilla for your computer version from the web, for example from 

http://www.clubic.com/lancer-le-telechargement-428669-0-filezilla.html  

b. Install FileZilla 

c. Open FileZilla (Figure 24) 

http://www.clubic.com/lancer-le-telechargement-428669-0-filezilla.html
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Figure 24: File Zilla interface 

d. Create a connection to the ftp web site that will deliver you the images you 

have ordered. For this, fill in the following boxes in FileZilla (red rectangle in 

Figure 24): 

i. Host: ftp.vito-eodata.be 

ii. Login : your login for the PDP 

iii. Password :  your password for the PDP 

e. And then click on “connexion”. This will connect you to your folder on the ftp 

site where you can download the ordered images. 

f. In the left panel of FileZilla, corresponding to your computer, browse to the 

directory where you want to record the images 

g. In the right panel of FileZilla, corresponding to the ftp server, browse to the 

folder containing the images you want to download. 

h. Then simply “Drag and drop” or “Copy/paste” the desired data from the ftp 

server to your computer target directory. It is advised to record all the images 

of a given sensor in a unique directory in order for the extraction process to 

go faster (cf. next section). VGT-S10 NDVI images for WEST-ASIA should be 

stored in the folder “...\DATA\NDVI 

IMAGES\SPOT_VGT\SPOT_VGT_WEST_ASIA\” of the training package. SPOT-

VGT images of 1998 and 2014 are useless for this methodology (complete 

year is needed).  

ftp://ftp.vito-eodata.be/
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8.5 NDVI images preparation for TIMESAT 

Once downloaded, satellite images need to be prepared to be readable into TIMESAT. 

SPOT VEGETATION, METOP AVHRR and PROBA-V are not provided in the same format. 

Specific process has to be applied on each image type. 

8.5.1 SPOT VEGETATION NDVI images preparation with VGT 
Extract 

Downloaded NDVI SPOT VEGETATION products cover WEST-ASIA and are recorded in ZIP 

files in a particuliar format. In order to be used in TIMESAT, these images will have to be 

converrted with the VGT Extract software. This operation will enable to: 

 Extract the NDVI images from the ZIP files 

 To subset the WEST-ASIA images to Tajikistan extent 

 To convert the images into “ENVI standard” format compatible with TIMESAT 

Note that this processing has already been done for the period 1999-2013 and that the 540 

resulting images are available in the training package in the directory “...\DATA\NDVI 

IMAGES\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN”. These images totalise a size of 

approximately 230 Mo.  

8.5.1.1 Extracting the NDVI images from the ZIP files 

Launch VGT Extract software. In the main interface of VGT Extract (Figure 25) you have to: 

 Define the “Input” directory: browse on your computer to the folder containing the 

zipped NDVI SPOT VGT folders. In the training package, it is the folder “DATA\NDVI 

IMAGES\SPOT_VGT \SPOT_VGT_WEST_ASIA\”.  

 Define the “Output” directory: browse on your computer to the folder that will 

receive the extracted NDVI SPOT VGT. In the training package, it is the folder 

“...\DATA\NDVI IMAGES\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN\” 

 Define a new “Processing Settings” for Tajikistan: clic on “New” and call it 

“SPOT_VGT_TAJIKISTAN_TIMESAT” for example. A new window (Figure 26) appears: 

confer next section. 
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Figure 25: VGT Extract main interface (process is executing).  

8.5.1.2 Subsetting the WEST-ASIA images to TAJIKISTAN extent 

In the appearing “ROI” interface of VGT Extract (Figure 26): 

 Choose the “Manual Input” mode (no predifined ROI are defined for Tajikistan) 

 Enter manually the following coordinates (in decimal degree) which surround 

completely Tajikistan (Figure 21): North = 41.1°, South = 36.6°, West = 67.3°, East = 

75.2°.  
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Figure 26: VGT Extract interface for ROI settings 

8.5.1.3 Converting the images into a format compatible with TIMESAT 

Then click on the “Output” tab of VGT Extract (Figure 27) and: 

 Choose “ENVI” as “Output format” and “Unsigned Byte” as “Data Type” (format 

compatible with TIMESAT) 

 Let the other parameter to default (“Scaling” of 1.0, “Offset” of 0.0 and “Missing 

Data Value” of 0.0 ). 

 Set the “Output Filename” to “%p_%y%m%d_%e which will result in filename such 

as, for example, “NDV_19990101_.img” 

See the “VGT Extract Software User Guide” for more information. In particular, the sections 

3.3 chips 6 and 7, section 3.6.3 and section 4.3 give explanations regarding the scaling, 

offset, missing data value and “Use product specific settings” box (leave it unchecked). 
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Figure 27: VGT Extract interface for Output format settings 

Launch the processing of the files by clicking on the “start” button of the main interface of 

VGT Extract. 2 types of files are produced (Figure 25):  

o “NDV_19990101_.img”, which are the NDVI images of interest 

o “SM_ 19990101_.img”, which are not of interest for this training. So they have to be 

deleted to spare disc place. 

The “ENVI” format will create for each image 2 files: 

 One containing the image itself with the extension “.img” 

 The other being the “header” file with the extension “.hdr” containing some 

metadata (coordinates system etc). This file can be opened with a text editor such as 

“Notepad++” for example. 

One image is composed of 885 columns (“samples”) and 505 lines. This information is 

available in the header file.  
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8.5.2 METOP AVHRR NDVI images preparation with 7-zip and 
FWTools 

8.5.3 Extraction and subset 

In order to be used in the model: 

 NDVI images and associated header files have to be extracted from the zipped folder 

 NDVI images have to be spatially subsetted on Tajikistan extent 

The sections below describe: 

 First, in details, the manual operations to realise these 2 tasks (time consuming)  

 Then the process automation by the use of a batch file used in command line (very 

fast) 

8.5.3.1 Extraction 

The extraction can be done with, for example, “7-zip” software. 7-zip can be downloaded 

from the following website http://www.7-zip.org/ and easily installed. 

After installation, all files can be extracted from the zipped folders, in one click, by: 

 Selecting all zipped folder 

 Right clicking and choosing “Extract here” 

All files will be extracted to the current directory. In order to spare disc space, non 

“…NDV.img” or “….NDV.hdr” can be deleted. 

8.5.3.2 Adding an information in the header files 

The spatial subset operation using GDAL (described in the next section) requires, 

beforehand, the addition, at the end of each header file, of the text line: “interleave = bsq", 

as explained at the end of Question 7 of the FAQ of Metop Website, here 

http://www.metops10.vito.be/metop-S10_pages/FAQ.html. This can be done manually for 

example, for each file. 

8.5.3.3 Subset and format selection 

The spatial subset on Tajikistan extent can be done with the free software “FWTools” that 

contains the GDAL library itself containing the “gdal_translate » utility that enables the 

raster subsetting. For more information on the subset process confer to the Question 7 of 

http://www.7-zip.org/
http://www.metops10.vito.be/metop-S10_pages/FAQ.html
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the FAQ of Metop Website here http://www.metops10.vito.be/metop-S10_pages/FAQ.html. 

GDAL_translate tool is fully described here: http://www.gdal.org/gdal_translate.html. More 

information on the spatial subsetting process can be found here: 

http://trac.osgeo.org/gdal/wiki/FAQRaster#HowdoIusegdal_translatetoextractorclipasub-

sectionofaraster. 

In order to spatially subset the images,  

 Download FWTools here http://fwtools.maptools.org/  under the section 

“download”. Choose “FWTools 2.4.7 (Windows 32bit)” if your computer is using 

Windows. This version is compatible with Windows 7 64 bits. This software is 

provided in the training package in the “SOFTWARE” folder. 

 Install FWTools by clicking on “FWTools247.exe” and follow the normal installation 

process. 

Once installed, this tool can be called via the command line window. Rather than using the 

command line window directly, it is easier to write the commands in a “batch file” (a text 

file with the extension “.bat” or “.cmd”). This can be done with “Notepad++” software for 

example, by creating a new file and saving it as “batch file” with the extension “.bat”. The 

elements of the command in the batch file are: 

 Directory and name of the command to execute with “ ” signs if there is space in the 

directory name. This indicates where the “gdal_translate.exe” has been installed. For 

example: "C:\Program Files (x86)\FWTools2.4.7\bin\gdal_translate.exe" 

 The gdal_translate function arguments: “-projwin ulx uly lrx lry” to identify the 

“subwindow” (spatial subset) coordinates in terms of geographic coordinates (“ul” 

stands for “upper left”, “lr” for “lower right”, “x” for “longitude”, and “y” for 

“latitude”). In the case of Tajikistan the subwindow coordinates used in “VGT 

EXTRACT” software for SPOT VEGETATION images are North = 41.1°, South = 36.6°, 

West = 67.3°, East = 75.2°. However the use of these coordinates on METOP AVHRR 

images with “GDAL_translate” results in an image of 504 lines and 885 columns, 

whereas the extracted SPOT VEGETATION images have 505 lines and 885 columns. 

This is not explain but is probably related to the fact that the SPOT VEGETATION 

images are 1 pixel bigger in longitude and latitude than METOP AVHRR images on 

WEST-ASIA extent as presented in the Table 1 page 39. In order to produce METOP 

AVHRR images of same size than SPOT VEGETATION images, the window North 

coordinate is extended a little (of 0.01 degree) as indicated below (Figure 21). This 

produces images with 505 lines and 885 columns. 

o ulx : the upper left longitude: 67.3 (degree) 

http://www.metops10.vito.be/metop-S10_pages/FAQ.html
http://www.gdal.org/gdal_translate.html
http://trac.osgeo.org/gdal/wiki/FAQRaster#HowdoIusegdal_translatetoextractorclipasub-sectionofaraster
http://trac.osgeo.org/gdal/wiki/FAQRaster#HowdoIusegdal_translatetoextractorclipasub-sectionofaraster
http://fwtools.maptools.org/


58 

 

o uly : the upper left latitude: 41.11 (degree) 

o lrx : the lower right longitude: 75.2 (degree) 

o lry: the lower right latitude: 36.6 (degree) 

o which results in the function: -projwin 67.3 41.1 75.2 36.6 

 Name of the input file, the image to subset, for example: 

METOP_AVHRR_20080101_S10_ASw_NDV.img 

 Name of the output file, the subsetted image to create, for example: 

METOP_20080101_TAJIKISTAN.img 

 The command “-of ENVI”, indicating that the output format will be of “ENVI 

standard” type, the format needed for TIMESAT, has to be added just after 

“gdal_translate.exe"”, otherwise the output format will be the default one i.e. 

“GeoTIFF”, and the image won’t be correctly read in TIMESAT. 

 The use of the command “pause” at the next text line prevent the automatic closing 

of the command line window after the operation and enable to check the right 

command execution. 

The final command should look like the following, on 2 lines:  

 "C:\Program Files (x86)\FWTools2.4.7\bin\gdal_translate.exe" -of ENVI -projwin 43 

67.3 41.11 75.2 36.6 “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\METOP_AVHRR\METOP_UNZIPPED\ 

METOP_AVHRR_20800101_S10_ASw_NDV.img" “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\METOP_AVHRR\METOP_TAJIKISTAN_SUBSET\ 

METOP_20080101_TAJIKISTAN.img" 

 Pause 

A similar command has to be written for each image to extract, which is fastidious (confer 

next section for automation). Once the batch file has been written, it has to be saved and 

closed. When double-clicking on that file, the process will automatically be launched. To 

open or edit the batch file, right-click on the file and choose “Notepad++” for example to 

open it.  
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8.5.3.4 Extraction and subset automation with command line 

In order to speed up the process extraction from the zip folder, header file modification and 

spatial subsetting can be done automatically by the use of a batch file used in the command 

line.  

The batch file to be used (and slightly adapted according to your working directory) can be 

found in “...\DATA\NDVI IMAGES\METOP_AVHRR\METOP_EXTRACT.bat”. This batch file can 

be open with “Notepad++” software by right clicking on it and choosing “Open with 

Notepad++”. 

Before using the batch: 

 The "7zip" software in command line version (available here http://www.7-

zip.org/download.html) has to be placed in the folder "... \TAJIKISTAN_CYFS_RS_2015 

\SOFTWARE\7zip_command_line\7za920\7za.exe".  

 The "FWTools" software (available here http://fwtools.maptools.org/) has to be 

installed on your computer. After installation, check that the installation directory is 

the same than the one mentioned in the batch file. If not, modify the batch file 

accordingly. 

 Metop WEST-ASIA NDVI images have to be downloaded in the folder "...\ DATA\NDVI 

IMAGES\METOP_AVHRR\METOP_WEST_ASIA_DOWNLOADED\” 

 The directory "...\ DATA\NDVI 

IMAGES\METOP_AVHRR\METOP_TAJIKISTAN_SUBSET\" has to exist 

Above the signs "..." represent the beginning of your working directory. If yours differs from 

the one used in the script file, you have to change it in the script file at the line beginning by 

"SET" by editing the file with a software such as “Notepad++” for example.  

The script is divided in 3 sections: 

 The first section enables the operator to set the working directory 

 The second section enables the extraction, with the “7-zip” software of the files 

"...NDV.img" and "...NDV.hdr" from downloaded zipped folders.  The commands are: 

o The full path to 7-zip executable 

o The command “e” that stands for “extraction from the zip” 

o The directory containing the zipped folder containing the files of interest 

ending with “*.zip” to take into account all zip folders of that directory.   

o The output directory where extracted files will be recorded 

o The names of the files to be extracted, in this case, only the files “…NDV.img” 

and “…NDV.hdr”. 

http://www.7-zip.org/download.html
http://www.7-zip.org/download.html
http://fwtools.maptools.org/
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o Note that “” signs are used for indicating directories when there are some 

spaces in directory names. 

 The third section enables the spatial subset of WEST-ASIA images on Tajikistan 

extent. The commands are organized in a 3 loop “FOR” to iterate the command on 

the images filenames containing 3 variables: the year, the month and the decade. In 

details, the commands are: 

o “for /L” enables to make an iteration by using a start value, a constant 

increment, and a end value. “for /L %%y in (2008,1,2015)” stands for “variable 

year from 2008 to 2015 by step of 1”, meaning 2008, 2009, 2010, 2011, 2012, 

2013, 2014, 2015. 

o “(for %%d in (01 11 21)” stands for: value 01, 11, 21. 

o “echo interleave = bsq >> "%Directory%...NDV.hdr" enables to add the text 

“interleave = bsq” at the last line of each header file 

o The code containing the “gdal_translate.exe" enables to spatially subset the 

NDVI image to Tajikistan extent 

o The script is repeated twice, one for month from 1 to 9, then for month from 

10 to 12. 

To run the batch file, simply double click on it. 

1 METOP AVHRR NDVI image has already been extracted on Tajikistan extent and is provided 

as example in the training package under the directory “...\DATA\NDVI 

IMAGES\METOP_AVHRR\METOP_TAJIKISTAN_SUBSET\”. This image is ready to be used in 

TIMESAT for the following of the process. METOP AVHRR image name structure is organized 

like this “METOP_20080111_TAJIKISTAN.img” (in this case, the second decade of January 

2008). 
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8.5.4 PROBA-V NDVI images preparation with PPT 

PPT can be used with a Graphical User Interface (GUI) or through command lines. In this 

manual, first the GUI is briefly presented and secondly the use of PPT through command line 

and batch file is presented.  

The PPT user manual is available in the folder “doc” of the PPT installation package. This 

user manual indicates how to use PPT with GUI and with command line. 

8.5.4.1 PPT GUI 

This section presents a summary of the indications given in the PPT user manual at the 

section “PROBA-V ProductCustomization Tool Graphical User Interface”. 

To start PPT: 

 Double click on the file “start.bat” in the folder “C:\PPT\gui\bin\”. A DOS consol 

should open briefly before the PPT GUI automatically opens (Figure 28).   

 Optionally you can create a “start.bat” shortcut on your desktop by right-clicking the 

“start.bat” file and select “send to > desktop”. 

 

Figure 28: PROBA-V ProductCustomization Tool (PPT) Graphical User Interface (GUI) 

In case of problem, if nothing happens, this may due to a problem with the installation of 

JAVA. You can try to uninstall and reinstall JAVA, available here: 

https://www.java.com/fr/download/manual.jsp. Double check that you respected the 

installation instruction and/or refer to the user manual.  

The operations to carry out on the downloaded PROBA-V images to prepare them for 

TIMESAT are: 

 Mosaic the 2 tiles of Tajikistan extent of each decade into 1 single image 

 Clip the images on the Tajikistan extent 

 Transform the images format into ENVI format, for compatibility with TIMESAT 

https://www.java.com/fr/download/manual.jsp
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To prepare PROBA-V images for TIMESAT: 

1. To open a PROBA-V product,  

 Click on the import button   

 Select a “.VRG” file in your data directory, e.g., “…\DATA\NDVI 

IMAGES\PROBAV\TAJIKISTAN\PPT_IN\PROBAV_S10_TOC_20131121_1KM_NDVI_V0

01.VRG” and open it 

 It should appear in the PPT left panel (Figure 30).  

 If the image cannot be added in the left panel of PPT, check the DOS consol and the 

error message, and check the section “Installation of Java Runtime Environment” of 

the user manual for error documentation. Maybe you will have to reinstall the Java 

version suited for your computer. 

 You can then optionally display the tiles location by selecting the file of interest and 

clicking on the display button  (Figure 29) 

 

Figure 29: Tajikistan PROBA-V tiles on the PPT WORLD MAP. 

2. To customize (process) the PROBA-V product: 

 Click on “Product customization” (Figure 30) button and fill the “I/O parameters” and 

“Customization parameters” as follow:  
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Figure 30: PPT left panel with 1 PROBA-V image open 

 

 Fill the “I/O parameters” (Figure 31):  

o Output File: the output filename has to contain the %DATASET% token 

because the selected output format is ENVI, e.g.: 

“20131121%DATASET%.img”. 

o Input file must be a “.VRG” file that indicates to PPT the tiles to use. 

o Creation of logging file is optional. 

 

Figure 31: PPT “I/O parameters” window 

 Customization parameters (Figure 32): 

o Output file format: ENVI format 

o Region of interest: Tajikistan extent (confer above and Figure 32). Check the 2 

boxes: 

 Perform clipping (cut the image on the desired extent). !! The North 

extent limit is set to 41,11. In order to have SPOT VEGETATION and 

PROBA-V NDVI images of same size (number of rows = 505 and 

number of columns = 885), which is more convenient for further 

process, the North extent limit (arbitrarily) has to be set to 41,11 in 

PPT extent setting. A value of 41,1 (as in VGT EXTRACT for SPOT 

VEGETATION) results in an image of 504 lines only. 
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 Perform mosaicking (merge the 2 tiles in 1 image) 

o Output projection: no reprojection. Don’t check the box. 

o Output dataset: no band extraction. Don’t check the box. 

 

Figure 32: PPT “Customization parameters” window 

3. Save the parameters file to your directory “…\DATA\NDVI IMAGES\PROBAV\” with the 

menu “File > Save as” of the customization window and call it 

“ProductCustomization_parameters.cfg” (Figure 33). 

 

Figure 33: PPT menu to save configuration file 

 
4. Click on the “Start” button to start the process (Figure 34) 
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Figure 34: PPT popup window when starting and finishing a process. 

This process results in NDVI image in ENVI format (.img and .hdr files (Figure 35)) mosaicked 

and clipped on Tajikistan with: 

 Number of rows/lines  : 505 

 Numbers of columns/samples : 885 

 

Figure 35: header file of an PROBA-V image processed with PPT 

The PROBA-V images resulting from this PPT process can be used in TIMESAT! 
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8.5.4.2 Use PPT with command line 

This section presents a summary of the indications given in the PPT user manual at the 

section “PROBA-V ProductCustomization Tool Command-Line Interface” and “commanding”. 

The process above can be repeated manually for all images. However in order to process the 

series of images faster, the process can be automated with the help of a batch file that can 

be executed in command line. 

Based on the indications of the “commanding” section of the “PPT user manual”, a batch file 

has been created to enable to: 

 Create and use configuration files needed for PPT for a series of PROBA-V images 

defined by the 3 variables "y" (year), "m" (month), "d" (decade). This .cfg file, called 

"ProductCustomization_parameters_batch.cfg", is overwritten for each combination 

of these 3 variables. Consequently, only the last requested .cfg file is kept on the hard 

drive when using the batch. 

 Apply the "ProductCustomization.exe" tool for each combination of these 3 

variables by using the configuration files created in the first step. 

This batch file is: 

 Available in the directory “…\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\PROBAV\” 

 Called “ProductCustomization_batch.bat”.  

This batch file is a simple text file of which the extension “.txt” has been modified to “.bat” 

which transforms this file in an executable file.  

To access to the content of this file: 

 Right-click on the file and open it with “Notepad++”.  

Some explanations on this file are given inside the file. The lines beginning by “rem” are 

comments lines and the other ones are command lines. 

Before to use the batch: 

 Adapt the directories of the batch file according to your computer and save the file.  

 Make sure you have the input data in the right directory and the PPT tool is installed 

and functioning properly before to launch the batch file. 

To launch the batch file: 

 Double click on the batch file. 
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This will: 

 open a DOS window 

 process all images of the input directory 

 produce desired images in the output directory (good format (ENVI), good extent 

(clip on Tajikistan extent), 1 image per decade (mosaicking the 2 tiles per decade)) 

After you used the batch: 

 Check that the images are produced in the output directory. 

Optionally you can check the content of the “ProductCustomization_parameters_batch.cfg” 

file produced by the batch in the folder 

“…TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI IMAGES\PROBAV\” by opening it 

with Notepad++. It should contain the right parameterization for a given PROBA-V image.  

 
The PROBA-V images resulting from PPT process can be used in TIMESAT! 
 

For some supplementary information on the PROBA-V images processing possibilities, refer 

to the following FAQ website http://www.vito-eodata.be/PDF/image/faq_help/Faq.html. 

 

http://www.vito-eodata.be/PDF/image/faq_help/Faq.html
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9 Valid data range during the process 

The “Valid Data Range” (VDR) and the “Code for Missing Data” (CMD) of the images will vary 

during the process when images are produced or transformed. In order to have a clear view 

of this evolution, their values are presented in the Table 2 below. 

Note that even if the CMD is set to “0” in TIMESAT processes, the VDR of the images 

produced by TIMESAT is always [0 - 255] for 8 bit images (smoothed NDVI images) and [-

32768 - 32767] for 16 bit images (season parameter images).  

In WinDisp it was decided to define the VDR as [1 - 255] in order not to overlap the CMD 

which is set to “0”. 

 WEB EXTRACTION TIMESAT WinDisp 

 Image download 
VGT EXTRACT, 
FWTools, PPT 

TSF_pro
cess 

TSF_fit2img 
Smoothed NDVI 

TSF_seas2img 
Season image 

Importation and 
header modification 

 VDR CMD VDR CMD VDR VDR CMD VDR CMD VDR CMD 

SPOT VGT* [1-255] 0 [1-255] 0 [1-255] [0-255] 
(8 bit) 

0 [-32768 -32767] 
(16 bit) 

0 [1-255] fitted 
[1-255] season 

0 

METOP 
AVHRR** 

[0-250] [251-254] 
[255] 

[0-250] [251-254] 
[255] 

[0-250] [0-255] 
(8 bit) 

0 [-32768 -32767] 
(16 bit) 

0 [1-255] fitted 
[1-255] season 

0 

PROBA-V*** [0-254?] 255 [0-254?] 255 [0-254?] [0-255] 
(8 bit) 

0 [-32768 -32767] 
(16 bit) 

0 [1-255] fitted 
[1-255] season 

0 

Table 2 : Chronological modification of Valid Data Range (VDR) and Code for Missing Data (or 
flag) (CMD) during the CYF methodology process. 

* SPOT VEGETATION VDR and CMD: VDR is [1-255].  This information can be found in the 

« VGT Extract » user guide issue 1.4.2 at page 20, section “An example: … NDVI datasets are 

stored as eight bits per pixel (or Byte) values, between 0 and 255, with 0 as flag value for missing 

data.” 

** METOP AVHRR VDR and CMD: this information can be found on the METOP website 

(http://www.metops10.vito.be/metop-S10_pages/main.html) in the section « Products > Spectral 

Aspects > in the table, at the line “NDV” and at the column “Digital Values V”.  

 [0-250]= Significant V-range. The scaling only holds for this range. Values beyond [0-

250] are flags. 

 [255] Per image, there is only one flag to indicate all "aberrant" states (Sea, NoData, 

NoValidData, Error). The Status Map image provides more information. 

*** PROBA-V VDR and CMD: 

 No information was found on the PROBA-V VDR but it is supposed to be [0-254] as 

the only information found was for the CDM which is 255 (information available in 

the header file of ENVI format PROBA-V image (after extraction with PPT)). 

http://www.metops10.vito.be/metop-S10_pages/main.html
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10 TIMESAT - NDVI images temporal 
smoothing and season parameters 
extraction 

Foreword. Note that the mention “(optional)” is written at the right of sections that doesn’t 

need to be executed for the CYFS methodology but that are however interesting to present 

to new TIMESAT user.  

 

TIMESAT (http://www.nateko.lu.se/timesat/timesat.asp) software is used, in this 

methodology, for (Figure 36): 

 Smoothing temporally the NDVI images 

 Extracting season (pheneology) parameters from images 

 

Figure 36: Illustration of TIMESAT process on NDVI temporal signal: smoothing (red) and 
season parameter extraction (start, end, etc). 

TIMESAT short presentation is given at the section 7.4 above.  

The 11 seasons parameters produced by TIMESAT are described at the page 23 of the 

“Timesat 3.1 Software Manual” (confer section 10.2 below).  

Note. Previously (with the old CYF methodology), the season parameters were extracted 

with the VAST3.0 software (FEWS – 1993). TIMESAT replaces VAST for the following reasons: 

http://www.nateko.lu.se/timesat/timesat.asp
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 No or very little documentation was available for VAST (eg. No detailed information 

on the smoothing algorithm) and no maintenance was realised. On the contrary 

TIMESAT is well documented and maintained will possible help staff.  

 TIMESAT probably provide a better temporal smoothing method and smoothed 

images are produced and available for cumuli computation whereas it was not the 

case with VAST.  

 Consequently the season parameters extraction is probably better with TIMESAT. 

10.1 TIMESAT download 

TIMESAT can be downloaded for free, for non-commercial academic research (see 

distribution policy), after registration, at: 

http://www.nateko.lu.se/timesat/timesat.asp?cat=4. Note that the retrieval of the login that 

will give you access to the download can take several days.  

Once logged, download  

 The software package version adapted to your situation. In this manual, the 

following situation will be considered: “TIMESAT standalone version 3.1.1 for 

Windows users without Matlab (zip archive, 2012-11-22, 181 Mb)”. The downloaded 

folder is “timesat311_standalone_windows32.zip” 

 You may also want to download some sample data under the section “Additional test 

data for TIMESAT” (Useless for this methodology). 

10.2 TIMESAT installation 

For detailed information on the installation refer to pages 36 and 37 (section 7) of “TIMESAT 

3.1 Software Manual” that comes with the download. The following section gives a 

summary of the installation steps: 

 Unzip the software package “timesat311_standalone_windows32.zip” in the 

directory “...\TAJIKISTAN_CYFS_RS_2015\SOFTWARE\TIMESAT\”. The software 

manual “timesat3_1_1_SoftwareManual.pdf” can be found in the directory 

“timesat311_standalone_windows32\timesat311\documentation\”. 

 If Matlab is not available on the computer it is necessary to first install a runtime 

engine called the Matlab Compiler Runtime (MCR). For Windows users, double click 

on the file MCRinstaller.exe stored in the directory 

“timesat311_standalone_windows32\timesat311\compiled\Win32\”. You might 

http://www.nateko.lu.se/timesat/timesat.asp?cat=4
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receive the following message ".NET Framework is not installed. If you require it, 

select Cancel and install “.NET framework” (available on internet through Google 

search) first, then start again the installation process. Otherwise select OK to 

continue". You can just continue the installation by pressing OK. See also section 7.4 

page 30 of this manual for more installation information (bugs and solution). 

 TIMESAT itself doesn’t need to be installed. 

10.3 Starting TIMESAT 

 To start TIMESAT double click on the file “TIMESAT.exe” in the 

“timesat311_standalone_windows32\timesat311\compiled\Win32\” folder. If the 

computer asks you if you want to execute the file, say yes. 

 Note that you may want to create a shortcut on the desktop for “TIMESAT.exe”. For 

this, right click on the executable file and choose “create a shortcut on the desktop” 

or “send to desktop”. 

 After double-clicking, a DOS command line window will appear. Wait a few seconds 

and then you will be asked to indicate the “TIMESAT installation folder”. Browse to 

the folder called “timesat311” as illustrated in the Figure 37 and click “OK”. This step 

is very important!! 

 

Figure 37: Indicating the TIMESAT installation folder when launching TIMESAT. 

 Then the “Timesat menu system”, which is the TIMESAT main interface, will open 

(Figure 38). 
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Figure 38: TIMESAT menu system 
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 In the “Timesat menu system” you have to indicate your working directory (Figure 

39 and Figure 40) (p. 37 and p. 43 of the “TIMESAT 3.1 Software Manual”). This step 

is really important and the rest of the methodology will repose on the definition of 

that working directory!!! The working directory is the directory where the TIMESAT 

RESULTS will be stored. This will also be the directory containing the batch files for 

TIMESAT process automation. The proper functioning of the provided batch files 

depends on that definition of the working directory (otherwise batch files have to be 

adapted). The provided TIMESAT list files are constructed relatively to this working 

directory (confer section 10.7.2). 

o Go in “TIMESAT menu system  > File > Preferences” and browse to your 

working directory, in this case: “...\DATA\NDVI IMAGES\RESULTS\.  

 

Figure 39:  way to set the correct working directory when starting TIMESAT. 

 

 

Figure 40: Defining the working directory in TIMESAT (in this case, the folder “RESULTS”). 
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10.4 Opening an image with TIMESAT (optional) 

NDVI images can be opened and visualized in TIMESAT with the menu “TSM_imageview”. 

This can be done to check that the images are correctly read by TIMESAT and to have an 

overview of them. This can also be used to visualize the output images of TIMESAT. To open 

and visualize one image:  

 Go in “File > Open Image File” and browse to the image to be opened (stored in the 

folders “...\DATA\NDVI IMAGES\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN” or 

“...\DATA\NDVI IMAGES\PROBAV\TAJIKISTAN\PPT_OUT”).  

 Indicate the following settings into the “Format” rectangle (Figure 41) 

o Image file type: 8-bit unsigned integer 

o Byte order: Little endian 

o No of rows in image: 505 

o No of columns: 885 

 Click on “Draw” button 

The image should draw in the visualizing window as presented in the Figure 42. 

 

Figure 41: TIMESAT image viewer “format” window 
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Figure 42: SPOT VEGETATION NDVI image of the first decade of May 1999 on Tajikistan in 
TIMESAT image viewer. 

Zoom and colour scale can possibly be changed. 
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10.5 File names convention in TIMESAT 

In TIMESAT, several file types are used regularly. In order to facilitate the database 

organization, it is suggested in this methodology (this is not compulsory for TIMESAT proper 

use) to respect a certain structure in the file names. A file name convention for the different 

file types of TIMESAT is proposed in the Table 3 below. 

 

Type of file 
E.g. for the 1999 

SPOT_VGT images 
E.g. for the 2008  
METOP images 

E.g. for the 2014  
PROBA-V images 

List file LIST_FILE_1999_SPOT_VGT.txt LIST_FILE_2008_METOP.txt LIST_FILE_2014_PROBAV.txt 

Settings file SETTINGS_1999_SPOT_VGT.set SETTINGS_2008_METOP.set SETTINGS_2014_PROBAV.set 

Job name in a 
settings file 

1999_SPOT_VGT 2008_METOP 2014_PROBAV 

.tts file 1999_SPOT_VGT_fit.tts 2008_METOP_fit.tts 2014_PROBAV_fit.tts 

.tpa file 1999_SPOT_VGT_TS.tpa 2008_METOP_TS.tpa 2014_PROBAV _TS.tpa 

Fitted (smoothed) 
NDVI images 

FITTED_1999_SPOT_VGT FITTED_2008_METOP FITTED_2014_PROBAV 

Season parameter 
images (e.g.: start) 

start_1999_SPOT_VGT start_2008_METOP start_2014_PROBAV 

Batch file 
(optional) 

BATCH_TSF_process_SPOT_VGT_
1999_2013.bat 

BATCH_TSF_fit2img_SPOT_VGT_
1999_2013.bat 

BATCH_TSF_seas2img_SPOT_VG
T_1999_2013.bat 

BATCH_TSF_process_METOP_20
08_2015.bat 

BATCH_TSF_fit2img_METOP_200
8_2015.bat 

BATCH_TSF_seas2img_METOP_2
008_2015.bat 

BATCH_TSF_process_PROBAV_2014
_2015.bat 

BATCH_TSF_fit2img_ 
PROBAV_2014_2015.bat 
BATCH_TSF_seas2img_ 

PROBAV_2014_2015.bat 

Table 3: File names convention in TIMESAT 
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10.6 Opening an image using a list file (optional) 

An image can also be opened by choosing it into a pre-built list file (page 44 of “TIMESAT 3.1 

Software Manual”). The construction of a list file is presented in the next section. To open an 

image from a list file: 

 Go in “File > Open File List > Open File List > browse to the list file of interest > click 

“open” > select in the list the image you want to open > click on “Close” > click on 

“Draw”. 

10.7 Creation of list files 

10.7.1 Introduction to the list files 

List file are used by TIMESAT to find where the image series are stored. List files are needed 

in TIMESAT for several things: 

 Viewing an image by selection of the image in a list (confer section 10.6 above – 

optional). 

 To use the TSM_GUI menu (mandatory)  

 To use the TSF_process menu (mandatory) 

List files are text files with the first line indicating the number of images in the list and the 

next ones indicating the directory to each of the images (confer page 41 and 74 of “TIMESAT 

3.1 Software Manual” for more information on list files).  

A list file can be created manually from a blank text file or by modification of an existing file, 

which is faster. In this case, some list files have already been created and are provided in the 

training package in the “RESULTS” folder under the name “LIST_FILE_...”. It is advised to 

open these list files with “Notepad++”. 

10.7.2 Absolute and relative list files 

Absolute list file 

A list file can be “Absolute”, meaning that each of his lines indicates the full directory 

(starting at directory’s root) to the image (e.g.: “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN\name_of_the_image.img”).  

Relative list file 
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A list file can be “Relative”, meaning that the directories to the images are written relatively 

to the TIMESAT working directory. That’s one of the reasons why it is very important to 

properly set the working directory when starting TIMESAT (cf. Section 10.3 for setting the 

working directory in TIMESAT).  

For example,  

 if the NDVI images are stored in the directory ” D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN\”, and that  

 the TIMESAT working directory is “D:\Projets\PREVISION 

RENDEMENTS\TAJIKISTAN\TAJIKISTAN_CYFS_RS_2015\DATA\NDVI 

IMAGES\RESULTS\”,  

 the path to a given SPOT VEGETATION image in the list file will be 

“..\SPOT_VGT\EXTRACTED_SPOT_VGT_TAJIKISTAN\SPOT_VEGETATION_19990101_T

AJIKISTAN.img”. 

Using a relative path has the advantage that you can move your “DATA” folder (to another 

computer for example) and the path to your images indicated in the list file will remain right 

provided that you choose the correct working directory when starting TIMESAT.  

Figure 43 gives an example of a relative list file for METOP AVHRR NDVI images of 2008 with 

a triple annual repetition as explained in next section. 
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Figure 43: Example of TIMESAT list file for 108 SPOT VEGETATION images (triple annual 
repetition) with relative path 

10.7.3 List file to process one year data with triple repetition 

As indicated in the “TIMESAT3.1 Software Manual” at page 21, the extraction of seasonality 

parameters from one year data, when vegetation season peaks around the middle of the 

year, which is the case for Tajikistan, require the creation and use of 2 artificial time series 

to be placed before and after the time series (year) of interest (Figure 44).  

The creation of 2 new time series by duplicating images can be avoided by the simple 

replication of 3 times the same 36 (in the case of decadal images) paths in the list file, as 

illustrated in Figure 43. 
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Figure 44: triple repetition of one annual NDVI evolution time series  

10.7.4 Preparation of a list file database 

In this case, relative list files (with triple annual repetition) have to be created for each year 

and stored in the “RESULTS” folder. Different list files can be created by duplication of 

existing list files and modification of their name and content. It is recommended to use the 

“replace” function of Notepad++ to modify their content. It is important to respect the 

filename convention presented in Table 3. 

These list files will be used by the “TSF_process” (confer section 10.9).  

Relative list file for long time series (e.g. 1999-2013) can also be created (without the annual 

triple repetition) in order to visualize the complete time series with “TSM_GUI” TIMESAT 

interface (confer section 10.8 below). 

A set of relative list files is provided in the training package in the “RESULTS” folder under 

the name “LIST_FILE_....txt”. 
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10.8 TSM_GUI 

10.8.1 TSM_GUI presentation 

Several inputs parameters need to be set before TIMESAT can process NDVI images series 

by running the “TSF_process”. These input parameters can be estimated optimally thanks to 

the program “TSM_GUI”. 

These parameters are described at the pages 24 to 30 and 74 to 77 of the “Timesat 3.1 

Software Manual” and define, among other, the NDVI smoothing method and the method 

to compute season parameters. The “TSM_GUI” interface enables to visually adapt the 

settings to the situation analyzed by presenting the effect of the settings on the smoothed 

NDVI curve and season parameters values. Once found, optimal settings can then be 

recorded in “Settings files”, which are small text files, listing the settings, and needed for the 

“TSF_process” application of TIMESAT. 

Note:  

 For detailed description of the smoothing algorithms refer to the section 3 of the 

“Timesat 3.1 Software Manual” 

 TIMESAT enables to work with land cover map and auxiliary quality data as 

described in the “Timesat 3.1 Software Manual”. The use of a land cover map can be 

useful to apply different settings to different land cover / areas. However, these 

options won’t be used in this methodology and the same settings will be applied on 

the whole Tajikistan. A possible enhancement of the methodology could be to apply 

different settings to different crops or areas (depending on the climatic conditions for 

example). It is not sure however that such method would give better results in terms 

of CYF. 

10.8.2 TSM_GUI utilization for settings definition 

The detailed use of TSM_GUI is described at the pages 45 to 52 of the “Timesat 3.1 Software 

Manual”. 

10.8.2.1 TSM_GUI utilization for a long time series (optional) 

In a first time (optional), TSM_GUI can be used to visualise the multi-annual NDVI evolution, 

for example for the period 1999-2013 for SPOT VEGETATION NDVI. To do that: 

 In “TIMESAT menu system”, click on TSM_GUI button. The TSM_GUI interface opens. 
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 Go in “Files > Open list of image files”. The “image_files_input” window opens (Figure 

45).  

 

Figure 45: The “image_files_input” window of TSM_GUI with some parameters, in this case for 
the 15 years (1999 – 2013) of the SPOT_VGT images series 

 In the “image_files_input” window, open the list file you want to visualize in 

TSM_GUI.   

 Indicate the number of years and images per year, in this case, 15 years with 36 

images per year 

 The image file type is “8-bit unsigned integer” 

 The number of rows is 505 and the number of columns is 885. 

 Click on “Show image” button and the “Figure Window” opens as in the Figure 46. 
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Figure 46: Figure window of TSM_GUI 

 The “Processing window” button enables to define a subwindow that identifies the 

pixels that will be the base for the settings definition in TSM_GUI main interface. 

Select a small pixels window that is representative of the crop areas of Tajikistan. 

 Click on the “Return” button. You come back to the “image_files_input” window. 

 The “Rows and columns to process” values are added in the interface according to 

the window you defined in the “Figure Window”. 

 Don’t use “Weight data” (leave the box unchecked). 

 Click on the “Load data” button. The TSM_GUI interface will present the complete 

NDVI time series (199-2012) for the first pixel of the window identified in the “Figure 

Window” above (Figure 47).  
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Figure 47 : SPOT VEGETATION NDVI evolution for the period 1999-2013 in TSM_GUI for a given 
pixel in Tajikistan. 

o Click on the “Plot next series” button to visualise the NDVI evolution for the next 

pixel in the window defined previously. 

o Note that the season parameters, for the considered pixel, for each year, are 

presented in the lower-right corner of the interface. 

For other options of the TSM_GUI window, confer the next section. 

10.8.2.2 TSM_GUI utilization for one year series (mandatory) 

In a second time (mandatory), TSM_GUI can be used on one year data to define the right 

settings for NDVI temporal smoothing and season parameters extraction. 

With the same process than the one described in the previous section, open, this time, a one 

year data list file that contains a triple repetition of one year (108 images = 3 * 36 decadal 

images). The number of year will thus be 3 and the graph window will present 3 times the 

same curve (Figure 48).  

Adapt the different settings in order to find the best fit (smoothing) to the NDVI raw data 

and to extract at best the season parameters. There is no general rule for identifying the 

best settings and the operators is encouraged to take an experimental approach by testing 

different settings. Note that it is really important that the pixels used in TSM_GUI to define 
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the settings have to be representative of all the pixels that will be considered by the 

TSF_process using these settings (confer section 10.8.2.3 for a settings suggestion).  

For “recommended” settings for Tajikistan, confer next section. 

Figure 48: TSM_GUI settings for Tajikistan for PROBA-V images for a triple repetition of a 1 
year time-series. 

Once the operator has adjusted the right settings in the TSM_GUI, the settings have to be 

saved into a “settings file”. To save the settings in a settings file: 

 Go in “Settings > Save to settings file”. And the “TIMESAT input settings tool” opens 

(Figure 49).  

 The settings defined in the TSM_GUI are already present in the “TIMESAT input 

settings tool”. Complementary settings, not present in the TSM_GUI, have to be 

adjusted. These are described in the next section 10.8.2.3.  

Once all the settings are completed,  

 Go in “File > Save settings file as” and browse to the “RESULTS” folder (which is the 

working directory) and name the settings file according to the file name convention 

presented in the Table 3 above (e.g.: “SETTINGS_1999_SPOT_VGT.set”). 



86 

 

Figure 49: TIMESAT input settings tool with proposed parameters value for Tajikistan for SPOT 
VEGETATION images 

The settings file is a simple text file that can be opened and modified with software such as 

“Notepad++” (Figure 50). 
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Figure 50: a settings file as opened with Notepad++ for the 1999 SPOT VEGETATION series 

10.8.2.3 Settings proposal for Tajikistan (description of the settings file) 

Some very quick and rough tests have already been carried out on NDVI time series for 

Tajikistan and settings for Tajikistan are proposed and justified in the Table 4 below. 

However, note that this is the result of a very quick and rough tests and that some settings 

could maybe be enhanced through further study. No sensitivity study of these settings on 

the CYF accuracy has been carried out yet. 

The settings are described according to their ranking in the settings file. The “valid data 

range setting” is different for SPOT VEGETATION and METOP AVHRR images, as explained in 
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the Table 4. Settings are described at the page 24 to 31 and 74 to 77 of the “Timesat 3.1 

Software Manual”.  

Row Parameter 
Parameter value 

Justification 
SPOT_VGT METOP PROBA-V 

1 Job name 
1999_SPO

T_VGT 
2008_MET

OP 
2014_PRO
BAV 

Confer the “file name convention” in Table 3, 
page 76 

2 
Image/series 
mode (1/0) 

1 1 1 This method uses images 

3 Trend (1/0) 0 0 0 
Option not in use. Confer the “Timesat 3.1 
Software Manual” 

4 
Use 

mask/quality 
data (1/0) 

0 0 0 This method doesn’t use mask or quality data 

5 
Data file 

list/name 

LIST_FILE_
1999_SPO
T_VGT.txt 

LIST_FILE_
2008_MET

OP.txt 

LIST_FILE_
2014_PRO

BAV.txt 
Confer the “file name convention” in Table 3* 

6 
Mask/Quality 
file list/name 

dummy dummy dummy 
As this method doesn’t use mask or quality 
data, any dummy name can be set 

7 Image file type 1 1 1 Images are 8-bit unsigned integer 

8 Byte order (1/0) 0 0 0 Images are in little endian byte order 

9 
Image 

dimension 
505 885 505 885 505 885 Dimension of the images for Tajikistan 

10 
Processing 

window 
1 505 1 

885 
1 505 1 

885 
1 505 1 

885 
The whole image has to be processed 

11 
Years and points 

per year 
3 36 3 36 3 36 

Years: always “3” as 3 times the same annual 

time series has to be used in TIMESAT list files 

in order to process an individual year (Confer 

the “Timesat 3.1 Software Manual” at page 

21.) 

Points per year: 36 as this method uses 

decadal images. 

12 
Valid Data 

Range (VDR) 
1 255 0 250 0 254 

Confer section “9. Valid data range during the 

process” 

13 
Mask/Quality 
range 1 and 

weight 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

This is the default value when no mask / 
quality data is used 

14 
Mask/Quality 
range 2 and 

weight 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

This is the default value when no mask / 
quality data is used 

15 
Mask/Quality 
range 3 and 

weight 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

-1e+006 
1e+006 1 

This is the default value when no mask / 
quality data is used 

16 
Amplitude 

cutoff value 
0 0 0 

As no study has been carried out to decide if 
some low amplitude series should not be 
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processed, 0 is used in order to process all 
series 

17 
Print functions 
and weights  / 
Debug (1/0) 

0 0 0 
In order not to print debug data 
(recommended) 

18 
Output files (1/0 

1/0 1/0) 
1 1 0 1 1 0 1 1 0 

In order to print seasonality data and fitted 
function but not the original time-series. 

19 
Use land cover 

(1/0) 
0 0 0 As this method doesn’t use any land cover file 

20 
Name of land 

cover file 
   

Empty as this method doesn’t use any no land 
cover file 

21 
Spike method 

(3/2/1/0) 
1 1 1 

The median filter seems to be an appropriate 
method 

22 Spike value 2 2 2 2 seems to be an appropriate value 

23 
No. of land 

cover classes 
1 1 1 As this method doesn’t use any land cover map 

24 Separator ******** ******** ******** The separator 

25 
Land cover code 

for class 1 
1 1 1 As this method doesn’t use any land cover map 

26 
Seasonality 
parameter 

1 1 1 
As there is just one season per year in 
Tajikistan** 

27 
No. of envelope 
iterations 1,2,3 

1 1 1 
If a value higher than 1 is used it seems that 
the small “second” season* is completely 
smoothed** 

28 
Adaptation 

strength (1-10) 
2 2 2 

Value of 2 is normal. It seems that this value is 
acceptable 

29 

Force to 
minimum (1/0) 

and value of 
minimum 

0 NaN NaN 
No apparent reason for forcing a minimum 
value 

30 
Fitting method 

(3/2/1) 
1 1 1 

The Savitzky-Golay filtering method seems the 
most appropriate*** 

31 
Weight update 

method 
1 1 1 

As indicated in the “Timesat 3.1 Software 
Manual” 

32 
Window for 

Savitzky-Golay 
4 4 4 4 seems to be an appropriate value 

33 
Season start 
method (2/1) 

1 1 1 
The proportional method seems to be the most 
appropriate 

34 
Season start / 

end values 
0.2 0.2 0.2 0.2 0.2 0.2 0.2 seems to be an appropriate value 

35 – 
45 

Data for class 2    Empty as this method doesn’t use any land 
cover map 

… …    

Table 4: settings proposal and justification for SPOT VEGETATION, METOP AVHRR and 
PROBA-V images for Tajikistan 
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Comments on some settings 

* Data file list/name: the default “data file list/name” (when recorded by TSM_GUI) is a full 

(absolute) path (from the disc root to the list file). However this long path can be shortened 

to the “file list name” only without any directory before, at the condition that the list file is 

stored in the working directory, in this case the folder “RESULTS”. It is advised to the user to 

follow this technique (Figure 50). 

** Number of season per year in Tajikistan: observation of annual NDVI evolution curve in 

Tajikistan revealed, for a non negligible proportion of pixels, the presence of a secondary 

NDVI maximum before or after the main maximum in the central season (Figure 48) 

depending on the areas. For some pixels a very small 2nd season is also sometimes observed 

after the central season, just before the winter. Hypothesis for explanation is a possible re-

growth of the vegetation after crop harvest and before bad season. These features are 

however not considered as real second vegetation season for TIMESAT processing.  

*** Fitting method:   the Savitzky-Golay filtering method seems the most appropriate as it is 

the method that best fit the data. The 2 other methods seem to smooth too much the NDVI 

profile and consequently reduce the accuracy of the season parameter computed from the 

NDVI curve.   

Notes on the use of TSM_GUI 

 It is primordial to keep, for a given region, the same settings for all the years. 

Settings could possibly vary according to region. This option is possible in TIMESAT by 

using a land cover file, but won’t be used in this method (confer section 10.8.1). 

 In a “triple annual repetition” time-series, TSM_GUI identifies the 2 “center-most” 

seasons only (Figure 48). Depending on the pixels, it can be year 1 and 2 or year 2 

and 3. 

10.8.2.4 Preparation of the settings files database 

One settings file has to be created for each year to process. Rather than to create them 

with TSM_GUI, it is easier to duplicate an existing settings file (copy/paste) and to edit the 

copy. The modifications to apply to each settings file are: 

 The name of the settings file itself (confer the file names convention in Table 3) 

 The “Job name” (confer the file names convention in Table 3) 

 The “Data file list/name” (confer the file names convention in Table 3) 

 The “Valid data range (lower upper)”, depending on the sensor type, SPOT 

VEGETATION or METOP AVHRR (confer the Table 4) 
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The settings files have to be placed in the “RESULTS” folder. 

A set of settings files is provided in the training package in the “RESULTS” folder under the 

name “SETTINGS_....set”. 

10.9 TSF_process (Data processing) 

The TSF_process is the central application of TIMESAT. It computes: 

1. the smoothed NDVI 

2. the season parameters 

To execute the TSF_process (one execution per year to process), 

 Click on the “TSF_process” button of “TIMESAT menu system” 

 Browse to the settings file for the year you want to process. 

TIMESAT will then launch the TSF_process. 

 Inputs of the TSF_process are the settings files. Note that the settings files call, in 

turn, the list files. When using relative path, list files and settings files have to be in 

the working directory, in this case the “RESULTS” folder. 

 Outputs of the TSF_process are the 2 packages: 

o  “jobname_fit.tts” : file containing the time-series constructed from the fitted 

functions (for the smoothed NDVI images) 

o “jobname_TS.tpa”: file containing the season parameters 

The TSF_process can take quite a long time to execute, depending on the size of the area to 

process and on your computer power (e.g.: 30 minutes for 1 year of images on the whole 

Tajikistan extent with a good computer, i.e.8h30 for 17 years data). 

Files “jobname_fit.tts” and “jobname_TS.tpa” are described in detailed at the page 31 of the 

“Timesat 3.1 Software Manual”. These files are not directly readable and TIMESAT propose a 

series of tools to have access to the information contained in these 2 files packages. These 

tools are presented in the next sections. Only 2 of these tools are necessary for this method: 

 “TSF_fit2img”: produces the temporally smoothed images (needed for the NDVI 

cumuli computation) 

 “TSF_seas2img”: produces the season parameters images 

Non necessary tools have the mention “(optional)” in their respective section titles below 

and are given as information. 
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10.10 TSM_fileinfo (optional) 

The “TSM_fileinfo” tool provides some basic information on the TIMESAT “.tts” and “.tpa” 

files. To use the “TSM_fileinfo” tool,  

 Click on the “TSM_fileinfo” button of the “TIMESAT menu system 

 Browse to the “.tts” or “.tpa” file that you want information on 

The “fileinfo” window will open as illustrated at Figure 51 and Figure 52 below. On METOP 

AVHRR images some water bodies are identified. On SPOT VEGETATION images these water 

bodies are not identified. This depends of the valid data range of both sensors which differs. 

For more information on the “TSM_fileinfo” tool confer the pages 52 and 69 of the 

“Timesat 3.1 Software Manual”. 

 

Figure 51: Fileinfo window for a “.tts” file for a SPOT VEGETATION image 
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Figure 52: Fileinfo window for a “.tpa” file for a SPOT VEGETATION image 
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10.11 TSM_printseasons (optional) 

The “TSM_printseasons” tool enables to view the season parameters values for selected 

pixels. To use the “TSM_fileinfo” tool,  

 Click on the “TSM_printseasons” button of the TIMESAT menu system 

 Browse to the “.tpa” file you are interested in 

 Go to the command line window and follow the indications.  

At the end of the process the “TSM_printseasons” tool will provide the season’s parameters 

values for the founded seasons of selected pixels as illustrated at Figure 53 below. 

For more information on the “TSM_printseasons” tool confer the pages 52 and 70 of the 

“Timesat 3.1 Software Manual”. 

Figure 53: TSM_printseasons command line window with season parameters values for the 
founded seasons of a selected pixel. 
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10.12 TSM_viewfits (optional) 

The “TSM_viewfits” tool enables to view the original and smoothed (fitted) NDVI curve for 

selected pixels. To use the “TSM_fileinfo” tool,  

 Click on the “TSM_viewfits” button of the TIMESAT menu system 

 Go to the command line window and follow the indications.  

At the end of the process the “TSM_viewfits” tool will display a graph illustrating the NDVI 

evolution curve for the selected period and pixels as illustrated at Figure 53 below. 

For more information on the “TSM_viewfits” tool confer the pages 54 and 70 of the 

“Timesat 3.1 Software Manual”. 

 

Figure 54: TSM_viewfits window presenting the NDVI temporal evolution curve of a given pixel 
for the “triple repetition” of one year NDVI time-series 
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10.13 TSF_fit2img 

The “TSF_fit2img” tool generates the temporally smoothed NDVI images. To use the 

“TSF_fit2img” tool,  

 Click on the “TSF_fit2img” button of the TIMESAT menu system 

 Browse to the “.tts” file you are interested in and click “Open” 

 Go to the command line window and follow the indications. The Table 5 below 

indicates the parameter value to use with the “TSF_fit2img”. 

Parameters Parameter values and justification 

Fitted data file name 
(“.tts”) 

E.g.: 1999_SPOT_VGT_fit.tts  

Confer the filename convention presented in Table 3 

Code to give to 
missing pixels 

0 

Propose to use 0 as 0 is the flag value in the SPOT_VGT images.  

Although 0 is a valid value for METOP AVHRR and PROBA-V, it 
seems better to indicate the same code for both SPOT_VGT and 
METOP in order to have comparable output files. Beside there is 
probably no / few pixel with 0 value in NDVI images. 

Name of output files 

(no extension!) 

E.g.: FITTED_1999_SPOT_VGT 

Confer the filename convention presented in Table 3 

File type for the 
output image  

1 

1 = 8-bit binary type. This type is selected because it is the data 
type of the original NDVI SPOT VEGETATION and METOP input 
images and output smoothed images will have to be imported in 
WinDisp that reads 8-bit binary image only 

Image no. to map  -1 

This will creates smoothed images for all images of the “.tts” file. 
Note that currently it is not possible in TIMESAT to select a range 
of images to process. Operator has to choose between 1 or all 
images. 

Table 5: “TSF_fit2img” parameters values and justification 

 The “TSF_fit2img” process is really fast and all 108 smoothed images will be recorded 

in the working directory for each year processed.  

 Only images of the second season, images from 37 to 72, have to be kept. All other 

images (1 to 36 and 73 to 108) have to be deleted (manually) to free disc space. 
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For more information on the “TSF_fit2img” process confer the pages 56 and 71 of the 

“Timesat 3.1 Software Manual”. 

“TSF_fit2img” process has to be run for each year. However it can also be run in command 

line with a batch file. Here is an example of command line instruction to use for Tajikistan 

(confer the section 10.16 about batch file in TIMESAT):  

 …\TSF_fit2img.exe 1999_SPOT_VGT_fit.tts 0 FITTED_1999_SPOT_VGT 1 -1 

10.14 TSF_seas2img 

The “TSF_seas2img” tool generates the season parameters images, i.e. 11 images per year. 

To use the “TSF_seas2img” tool,  

 Click on the “TSF_seas2img” button of the TIMESAT menu system 

 Browse to the “.tpa” file you are interested in and click “Open” 

 Go to the command line window and follow the indications. The Table 6 below 

indicates the parameter value to use with the “TSF_seas2img”. 

Parameter Parameter value and justification 

Season data file name (“.tpa”) E.g.: 1999_SPOT_VGT_TS.tpa 

Confer the filename convention presented in 
Table 3 

Seasonal parameter to output E.g.:  1 

This will produce the “start of the season” image. 
“TSF_seas2img” process has to be repeated for 
11 season parameters, from 1 to 11. 

Somewhat wider interval than 
the dates between which the 
season of interest is expected to 
occur. 

25,80 

These values seem to fully encompass the second 
season (the one of interest) in the “triple annual 
repetition” time-series (108 images).  

Code to put if season is not found 
between min and max dates 

0 

Code for missing pixel for other 
reason 

0 

Name to append to the output 
files  

E.g.:  start 

Give a name corresponding to the season 
parameter being processed (proposed names are 
given in Table 8, column 1, below) 
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Specify the file type for the 
output image files (2 or 3) 

2 

2 = 16-bit signed integer (values will be rounded 
to nearest integer). 8-bit format is not available. 
16-bit season images will have to be converted to 
8-bit during the importation in WinDisp. 32-bit 
format is not supported by WinDisp. 

Table 6: “TSF_seas2img” parameters values and justification 

 The “TSF_seas2img” process is really fast and 2 “start season images” will be 

recorded in the working directory for each year processed (section “TSF_seas2img: 

Creating an image from the seasonality data” of TIMESAT manual, page 58): 

o Image with “s1” extension for the 1st season of the central year (year 2 in the 

triple annual repetition (Figure 44)), which is the image to be considered in 

this methodology 

o Image with “s2” extension for the 2nd season of the central year (year 2 in the 

triple annual repetition(Figure 44)). In the case of Tajikistan, as there is only 1 

season per year, the “s2” image will be mainly composed of pixel with the 

code for missing season, i.e. 0 in this manual. This images “s2” is useless.  

Remarque on the season number as identified in TIMESAT 

When considering a “triple annual repetition” NDVI time-series in Tajikistan, 

 In TSM_GUI and TSM_print_seasons, the 2 identified seasons (among the triple 

annual repetition) are the 2 “center most” seasons (confer TIMESAT manual section 

4.1). Depending of the pixels and vegetation behaviour in these locations, and in the 

case of 1 season per year, it can be during year 1 and 2 OR year 2 and 3.  

Table 7: Remarque about the season’s number as identified in TIMESAT 

For more information on the “TSF_seas2img” process confer the pages 57-58 and 71-72 

of the “Timesat 3.1 Software Manual”. 

“TSF_seas2img” process has to be run for each year and season parameter. However it can 

also be run in command line with batch file. Here is an example of command line instruction 

to use for Tajikistan (confer the section 10.16 about batch file in TIMESAT):  

… \TSF_seas2img.exe 1999_SPOT_VGT_TS.tpa 1 25 80 0 0 start_1999_SPOT_VGT 2 

Table 8 presents the range of season parameters values as observed on “TSF_seas2img” 

outputs for 1999 SPOT VEGETATION time series on Tajikistan. It is useful to know these value 

ranges in order to know what conversion factor to apply when importing in WinDisp which 



99 

 

handle only 8-bits data, i.e. data in the [0-255] value range (confer section 11.3.2.1). Note 

that some (very few) negative values are observed for the 2 parameters “Increase” and 

“Decrease”, which is not explained. “Large” and “Small” season parameters are the only 2 

season parameter to have values higher than 255. 

Season parameter Value range for 1999 SPOT VEGETATION images on Tajikistan 

Start 0 to 67 

End 0 to 80 

Length 0 to 35 

Base 0 to 94 

Middle 0 to 81 

Max 0 to 242 

Ampli 0 to 235 

Increase -15 to 61 (but mostly positive) 

Decrease -11 to 41 (but mostly positive) 

Large 0 to 4512 

Small 0 to 3480 

Table 8: Range of season parameters values as observed on “TSF_seas2img” outputs from 
1999 SPOT VEGETATION images on Tajikistan 

10.15 Viewing smoothed NDVI and season 
parameters images with “TSM_imageview” 
(optional) 

The smoothed NDVI images and the season parameters images can be visualized in TIMESAT 

with the “TSM_imageview” tool. Figure 55 gives an overview of TIMESAT output images for 

SPOT VEGETATION 1999 time-series. 

Note that some histogram graph present unexplained shape for certain parameters:  

 “Ampli” and “Maximum” season parameters graphs have a jagged behaviour 

 “Middle” and “Start” season parameters graphs have some gaps (missing columns) 

 “Increase” and “Decrease” season parameters graphs have some negative values 
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Figure 55: Overview of TIMESAT output images for SPOT VEGETATION 1999 time-series on 
Tajikistan extent 
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10.16 Using Batch file in TIMESAT 

Many operations in TIMESAT are repetitive and time consuming if the operator has to 

manually repeat all operations. The use of the interactive command line window is 

particularly time-consuming, for example for: 

  “TSF_fit2img” process, that has to be repeated for each year (1999-2015) (i.e.: 17 

times) 

 “TSF_seas2img” process, that has to be repeated for each year (1999-2015) and each 

of the 11 season parameters (i.e.: 187 times).  

 “TSF_process” process has to be repeated for each year (1999-2015) (i.e.: 17 times) 

The use of batch files (a simple text file with the “.bat” extension) enables to execute all the 

repetitions of a given process in just one click by writing in the batch file the commands to 

execute. TIMESAT doesn’t need to be opened to run the batch files since the batch file will 

automatically call the “.exe” files of TIMESAT. To run the batch, double-click on it. Table 9 

presents examples of commands to be written in batch file for the 3 TIMESAT processes 

“TSF_process”, “TSF_fit2img” and “TSF_seas2img”. Each command has to be written on one 

line and is composed of: 

 The directory indicating the “.exe” file directing the command, followed by 

 The arguments of the command 

In order to ensure the execution of all the desired processes (for all years and/or season 

parameters), command lines have to be duplicated in the batch file, written each on one line 

and adapted. The variation between command lines will be, for: 

 “TSF_process”: the names of the settings files 

  “TSF_fit2img”: the names of the “.tts” files and output files 

 “TSF_seas2img”: the names of the “.tpa” files, the number identifying the season 

parameters (1-11) and the names of the output files (“start”, “end”, etc). 

Process Command to be written in the batch files 

TSF_process ..\..\..\SOFTWARE\TIMESAT\timesat311_standalone_windows32\timesat311\ti

mesat_fortran\main\TSF_process.exe SETTINGS_1999_SPOT_VEGETATION.set 

TSF_fit2img ..\..\..\SOFTWARE\TIMESAT\timesat311_standalone_windows32\timesat311\ti

mesat_fortran\tools\TSF_fit2img.exe 1999_SPOT_VEGETATION _fit.tts 0 

FITTED_1999_SPOT_VEGETATION 1 -1 

TSF_seas2img ..\..\..\SOFTWARE\TIMESAT\timesat311_standalone_windows32\timesat311\ti
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mesat_fortran\tools\TSF_seas2img.exe 1999_SPOT_VEGETATION _TS.tpa 1 25 

80 0 0 start_1999_SPOT_VEGETATION 2 

Table 9: Examples of commands to be written in batch file for the 3 TIMESAT processes 
“TSF_process”, “TSF_fit2img” and “TSF_seas2img” 

Batch files needed in TIMESAT for the 3 processes “TSF_process”, “TSF_fit2img” and 

“TSF_seas2img” are provided in the training package in the folder “RESULTS”, where the 

batch files have to be placed in this methodology. The directory to the “.exe” files is given as 

“relative path” (confer section 10.7.2) compared to the working directory. Consequently the 

folders organization given in the training package has to be respected or the directory to the 

“.exe” files has to be adapted in the batch file (confer also next section). The execution of 

these batch files, provided that the suggested directories organisation is respected and that 

depend files (images, list files, settings files) are also in the right directories and correctly 

written, will produce all TIMESAT outputs necessary for the CYFS. 

The next section gives some general considerations to have in mind when working with 

batch files in TIMESAT.  

 Some information on how to use batch file in TIMESAT are given at the pages 61 and 73 

of the “Timesat 3.1 Software Manual”. 

The “TSF_fit2img” batch file will produce for each year images from 1 to 108, corresponding 

to the 3 annual repetitions used in the TIMESAT list files. Only images from 37 to 72 have to 

be kept and fitted images 1 to 36 and 73 to 108 can be deleted. This can be done 

automatically with the provided batch file “...\DATA\NDVI IMAGES\RESULTS 

\BATCH_DELETE_SUPERFLUOUS_FITTED_IMAGES.bat”. 

10.16.1 General considerations for working with batch files in 
TIMESAT 

When using batch files the operator will have to pay attention to the following points: 

 A batch file has to be written in a text file with the “.bat” (or “.cmd”) extension 

 TIMESAT doesn’t need to be open before executing the batch file. 

 The folder containing the batch file: 

o  Defines the “Working Directory” (WD) of the process called by the batch file 

(which can be different than the WD set in the “Preferences” menu of 

TIMESAT). The WD of a process is the folder containing the batch file calling 

that process. 

o Will be the folder where all results are stored 
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o In this methodology, it will be the folder “RESULTS” 

o In this methodology, the WD has also to contain the settings files and the list 

files (see explanation hereafter): 

 The batch files: 

 Use a relative path to the TIMESAT “.exe files” 

 Use no path to the settings files, so the settings files have to be 

in the same folder than the batch files 

 The settings files: 

 Use no path to the list files, so the list files have to be in the 

same folder than the batch files. (The settings files could be 

somewhere else if, in the batch, a full directory is used to 

indicate where the settings files are) 

 (Note that the path to the list file can have space and can be 

relative). 

 The list files: 

 Use a relative path (relative to the WD) to the image files 

 Take care of having the files called by the process ready, for example, for the: 

o TSF_process.exe: the “settings files” and the “list files” of each year to be 

processed. 

o TSF_fit2img.exe, the “.tts” files of each year to be processed.  

o TSF_seas2img.exe, the “.tpa” files of each year to be processed. 

 The directory pointing to TSF_process.exe can be written in relative mode if there is 

no space in the written directory (there can be space if they are included in the 

“..\..\”  and so not “written”). “” signs have to be added when there are written 

spaces in the directory pointing to the “.exe” file. 

  (Note: when working on big countries or with not powerful computer, for testing 

batch file, it can be good to work on small processing window in order to fasten the 

process)  
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11 WinDisp – computing statistics by 
zones 

! In this section, some examples use Armenian data! Same principles are valid for 

Tajikistan.  

11.1 Introduction 

WinDisp is mainly used in the CYFS to compute spatial statistics on smoothed NDVI images 

and season’s parameters images computed in TIMESAT. These statistics are mainly the 

average of the pixels values by spatial zones that correspond to the intersection of a given 

crop location with the Marzes (administrative unit) of Armenia. The 3 crops considered in 

this case are wheat, cotton and potato. 

The images process for CYFS in WinDisp consists in 3 steps: 

1. Importation of images 

2. Modification of image header 

3. Spatial statistics computation 

These operations can be speeded up with the use of batch file (as for TIMESAT). The 

statistics are recorded in charts that will be used in the statistical part of the CYFS. 

WinDisp can also be used for complementary operations that can be useful for the CYFS, 

such as: 

 Visualizing NDVI images 

 Visualizing the NDVI temporal evolution curve for selected pixels and realizing 

various graphs 

 Realizing maps (e.g.: NDVI stress maps) 

 

The next sections are organised as follow:  

1. First an introduction to WinDisp that will give the basics (and a bit more) to beginner 

users to correctly handle WinDisp for CYFS. 

2. The use of WinDisp for the CYFS 

3. The methodology for building boundary files 

4. The process automation by the use of batch files 

5. Computation of cumulated NDVI values per phenological period in Excel 
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Data needed to work in WinDisp are provided in the training package in the directory 

“...\DATA\WINDISP DATA\”. In particular, a sample images ready to be used in WinDisp 

(correct format) is provided in the training package in the directory: “...\DATA\WINDISP 

DATA\WINDISP sample images\”. These images correspond to the SPOT VEGETATION NDVI 

images for 1999, on Tajikistan, smoothed by TIMESAT.  

11.2 Introduction to WinDisp 

A short introduction to WinDisp software, download and installation process is described in 

section 7.5.  

Data mentioned in the introduction above can be used to follow the indication in this 

section.  

11.2.1 Displaying information 

This section introduces to the WinDisp interface and basic manipulations to visualize data.  

To start WinDisp, 

 Double click on the WinDisp icon appearing on your computer’s desktop after 

WinDisp installation 

To open an image, 

 Click on « File > Open >Image » (Figure 56).  

 

Figure 56: opening an image in WinDisp 

 Open, for example, the provided NDVI image “FITTED_1999_SPOT_VGT_58”.  

 In the field « Color table », open the file «…\ DATA\WINDISP DATA\CLR 

FILES\NDVI.CLR».  

Color tables are used to transpose the values of the image pixels (DNs – Digital Numbers) to 

specific colors when displaying an image.  

 Keep default value unchanged for other parameters, and then click OK. The NDVI 

Spot-Vegetation image opens (Figure 60).  
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To add a map of the Armenian provinces (Marzes) to this image, 

 Go to « File > Retrieve > Map » (Figure 57).  

 

Figure 57: adding a map in WinDisp (1) 

The following box displays Figure 58: 

 

Figure 58: adding a map in WinDisp (2) 

 

 In “Map file” (first line), browse to the file “…\DATA\WINDISP DATA\BNA FILES\ 

ARMENIA_MARZES.BNA » in order to open it. This is a map file of the first 

administrative level of Armenia.  

 The others parameters relate to the layout (keep their default values unchanged).  

The administrative units appear on the NDVI image (Figure 60).  

In order to easily identify what are the names of these  geographic-administrative units,  

 Click on “Draw\Labels” in the main toolbar. Then for the “Map File”, browse to 

“ARMENIA_MARZES.BNA ” (same as above). Keep the default parameters for the 

other fields as indicated in Figure 59. Then click OK.  
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Figure 59: drawing labels in WinDisp 

 
You should now get the names of the administrative area on each unit (Figure 60). Figure 60 

illustrates the visualization of spatial information in WinDisp (image, map, labels). 

 

Figure 60: Visualizing spatial data in WinDisp: image, map, label, coordinates, and legend. 
Image is NDVI SPOT VEGETATION 10 days Synthesis. The map is the first administrative level 

of Armenia. 

The icons   give you the possibility to choose the display that best suits you. You can 

zoom on Erevan province for example. 

If you move the cursor around the image, some information appears at the bottom of the 

screen (Figure 61): 
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 The first pair of numbers on the left (outlined in red) is the cursor position on the 

screen in « screen pixel » (depending on the screen resolution).  

 The second pair of numbers (in green) is the cursor position on the image in « image 

pixel ».  

 The third pair (in yellow) represents the cursor position in geographic coordinates 

(longitude, latitude).  

 The last number (in black) is the pixel value, NDVI value in this case.  

 If you click on a cartographic feature (selected in black in the image bellow) the name 

of the administrative unit selected will appear in the last box (outlined in brown in 

the Figure 61). 

 

Figure 61: Display information in WinDisp (Pakistan coast) 

11.2.2 Making list files and NDVI temporal evolution graphs 

Spatial statistics computation in WinDisp requires the creation of list files specific to 

WinDisp. The following section explains how to create list file and how list files can be used 

to visualize NDVI temporal evolution in graphs for selected pixels. 

The function « View > Graph > Image Series” is used to display a graph of the temporal 

evolution in a series of images, of the values of a designated pixel.  

To evaluate the NDVI evolution during the year 1999 on the basis of a series of 36 Spot 

Vegetation images of 1999.  

To create a list file (« .lst » file) in WinDisp, 

 Open an NDVI image, e.g. the image of the 1st decade of January 1999 with the NDVI 

color table. Click OK. The NDVI image appears. 

 Go in “View > Graph > Image Series” menu (Figure 62). The “View graph image 

series” window opens.  
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Figure 62: building of an image list in WinDisp (1) 

  Click on the browse button . An empty “List Builder” window appears. 

 Click on « File > New » and enter the number of lines (36 since there are 36 SPOT 

Vegetation images for 1 year) and columns (1 since we want to view one images 

time-series at a time only. 2 columns would graph 2 time-series in parallel).  

 Click on « Files > add » and browse to the decadal Spot Vegetation NDVI images for 

1999 in the “...\DATA\WINDISP DATA\WINDISP sample images\” directory. While 

holding the « shift » key (or “ctrl” key) pressed, click on the first and then the last 

images of the wanted series. Click OK. When creating the list file, be careful and 

check that the images are in the chronological order. 

The window « List Builder » should now contain all the images sorted (from the first decade 

of January to the last decade of December) as shown for example in Figure 63.  

 

Figure 63: building of an image list in WinDisp (2) 

 Click on « File > Save As » and save this list in the directory “...\DATA\WINDISP 

DATA\LIST FILES\Test\” and call it “test_FITTED_1999_SPOT_VGT.lst”.  

 Close the window « List Builder » and click OK. 

The list file is created. As list file are text file, similar list files, for other years for example, 

can be created by duplicating existing list file and editing them with the software 

“Notepad++” for example (confer section 10.8.2.4). 
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When closing the window « List Builder », in addition to the NDVI image, a «graph window»  

opens.  

To visualize the NDVI temporal evolution during the time-series of the list file in a graph, 

 Click on a given pixel of the image, and the graph appears in the « graph window» 

(Figure 64 to Figure 66). 

Note that the unit of the Y-axis of the “Graph – Image Series” function is DN [0-255]. 

 

Figure 64: SPOT VEGETATION NDVI evolution in 2001 on Lake Sevan (red point) 

 

Figure 65: SPOT VEGETATION NDVI evolution in 2001 and 2002 in pasture (cross) (list file with 
2 columns, one column per year) 

 

Figure 66: SPOT VEGETATION NDVI evolution from April 1998 to January 2011 in pasture 
(cross) 
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Figure 67 illustrates the annual NDVI evolution on Tajikistan for the 1999 SPOT VEGETATION 

time series. 
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Figure 67; SPOT VEGETATION NDVI evolution in Tajikistan in 1999 (1
st

 decade of each month) 
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11.2.3 Computing statistics 

11.2.3.1 Process of images series (input: images series, output: 1 image) 
(optional) 

(This section is given as indication and is not useful for the CYF methodology.) 

The set of commands located in « Process \ Series », give the possibility to calculate 

temporal statistics by pixel. Some of these processes are similar to the ones of TIMESAT. 

 The input is a list file identifying a series of images (e.g.: image series of 1999).  

 The output is an image of which each pixel represents the result of the process 

implemented to the corresponding pixels of the chosen images series (e.g.: the 

maximum image value encountered during 1999). 

The following statistics are available:  

Max  Maximum value 

Min   Minimum value 

Avg   Average value 

Median Median value 

Range  Range of values 

Sum   Sum of values 

Count  Number of valid pixels 

Stddev  Standard deviation of values 

Decloud  Temporal smoothing technique 

Slope  Slope of trend-line of values 

MaxDate When the maximum value occurs 

MinDate When the minimum value occurs 

To evaluate the date when NDVI is maximal during the year 1999,  

 Click on « Process > Series > MaxDate ». The empty “Process Series MaxDate” 

window opens (Figure 68). 

 

Figure 68: the “MaxDate” process of WinDisp 

 Click on the browse button  located next to « File list of image names ». The “List 

builder” window appears.  
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 Go in “File > Open” and browse to the list file you’ve created previously 

“...\DATA\WINDISP DATA\LIST FILES\Test\test_FITTED_1999_SPOT_VGT.lst”. This 

selects the images series you want to compute statistics for. 

 Then close the “List Builder” window.  

 In the “Image to create” box, browse where you want to place your resulting file (for 

example in “…\DATA\WINDISP DATA\Process series\) and give it a name and 

extension (e.g.: “MAX DATE 1999.arm”). 

 Click OK.  

The “statistics image” is now recorded in your repertory. To visualize it (Figure 69), 

 Open it as a normal image (confer above) but 

 Use a color table adapted to the “statistic image” values. “…\DATA\WINDISP 

DATA\CLR FILES\36_DATES.clr”. This color table is adapted to visualize values ranging 

from 1 to 36 which is the value range of the “MAX DATE” parameter (36 decades in a 

year). 

 

Figure 69: spatial representation of the “MaxDate” parameter of the “Process Series” function 
of WinDisp for 2001. 

11.2.3.2 Process Statistics. 

This process is the main one used in WinDisp for CYFS. 

The commands situated in “Process\Stats\...” enables to calculate temporal and regional 

statistics for certain area represented in a map.  

 The inputs are a list file of “smoothed NDVI images” or “season parameters images”, 

and a map identifying the areas for which to compute the statistics.  
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 The output is an ASCII chart containing the statistic values per date (columns) and 

areas (lines).  

The following statistics are available. 

Max   Maximum value 

Min  Minimum value 

Average  Average value 

Median  Median value 

Stddev  Standard deviation of values 

Range  Range of values 

Count    Number of valid pixels (between the maximum and minimum thresholds) in a  

  polygon 

To compute statistics with “Process\Stats\...”, e.g. for the average value, 

 The first thing is to have or to create a list file which contains the image series to be 

processed (confer section 11.2.2). A list file may contain for example the 36 images of 

a given year or the 15 (15 years time series) images of a given season parameters. 

 Go in “Process > Stats > Avg” (Figure 70). The “Process Stats Avg” window opens. 

 

Figure 70: “Process\Stats\...” function of WinDisp 

 Select the list file of interest (e.g.: list file of 1999 NDVI images series, or list file of all 

“starting decade” images series) 

 Select the map file (“.bna” file) of interest, in the box “Map file”, for example the 

“...\DATA\WINDISP DATA\BNA FILES\WHEAT_ARMENIA_MONOPART.BNA” file if you 

want to compute statistics for wheat areas in Armenian Marze. Remarque that if the 

information on the localization of the specific crop targeted by the model is available, 

it is better to use one specific “.bna” file per crop. Using a shapefile (*.shp) is also 

possible but you will get number instead of administrative names (eg. Provinces 

names) in the first column of the output statistics chart. Using a “*.bna” file will 

provide administrative names in the statistics chart, which is better.  
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 Browse and give a name for your output file with the extension “.xls”. The use of the 

“.xls” extension produce Excel chart, which is important in this methodology. 

 In the box “Window around point”, keep default value. This parameter is used to 

define the area around a pixel (for example a meteorological station) which can be 

included in the analysis of the pixel. In the case of analysis linked to polygons this 

parameter is not used, so its value by default is equal to 1. 

 Important remark: by default, if more than half of the polygon (half of the pixels in a 

polygon) contains pixels outside the relevant thresholds, a value of -9999 is returned.  

Both the thresholds and the percentage of the polygon that needs to be valid can be 

modified with the “Process > Thresholds > command”. 

 

Figure 71: “Process Stats Avg” function in WinDisp 

 Click “Ok”.  

Excel will open automatically and the results will be displayed as in the table presented in 

Figure 72. Wait a little if you do not get results directly. If Excel does not open automatically, 

browse to your output folder and open the output file (Figure 72). 

... 

Figure 72: Statistics chart in Excel for the Average value of “CUMM” VAST parameter by area 
identified in a “.BNA” file. 

In this chart, the two first columns correspond to the 2 attribute fields of your BNA file. 

There is one line per geographic unit of your BNA file, here, one line per province. The 

column 3 and the following one’s identify the images which were processed, for examples: 

 If you computed the average statistics for the 36 NDVI images of a given year, you 

will get 36 columns, each corresponding to the average NDVI of 1 decade, by areas. 
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For example, the first column will be the average NDVI of the 1st decade for the given 

year by areas.  

 If you computed the average statistics for the 15 TIMESAT outputs images “start” 

(start of the season) from 1999 to 2013, you will get 15 columns, each corresponding 

to the average, by areas, of the “start of the season” for one year. For example, the 

first column will be the average “start of the season” for 1999 by area. 

The Excel table will contain as many lines as there are of spatially distinct areas in the 

“.BNA” file used in the statistic process. Consequently, if for example there are “n” crop 

areas in the administrative area named “x”, the Excel table will contain “n” lines 

corresponding to the administrative area “x”. The aggregation of this information by Marz is 

quite fastidious as described in section 11.3.4.1 and 11.4. That’s why it is recommended to 

use a simplified map file with a single crop area per administrative area (confer sections 

11.3.4.1 and 11.4).  

The code “-9999” will be set for areas/dates where no data could be computed. These have 

to be treated as “no data” or replaced with the mean value of all the Marzes for the 

considered period. This can be done in the statistical part of the CYFS. 

When re-computing with WinDisp statistical charts that already exist, existing statistical 

charts will not be overwritten but new statistical information will be added next to the 

existing information in the existing file (in new columns). Besides if existing charts files are 

not deleted and new statistics are computed with a new bna file that does not respect the 

same administrative areas names, number and order, WinDisp batch will bug. So when re-

computing statistical charts in WinDisp, existing charts have to be preventively deleted. 
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11.3 WinDisp for Crop Yield Forecasting System 

11.3.1 WinDisp filenames convention  

In order to better organize the files to be produced in WinDisp, a file name convention is 

proposed in Table 10. 

Type of file GENERIC_EXAMPLE 

 REAL_EXAMPLE 

Imported fitted images TYPE_YEAR_SENSOR_DECADE 

 FITTED_1999_SPOT_VGT_37 

 FITTED_2008_METOP_37 

 FITTED_2014_PROBAV_37 

Imported season images PARAM_YEAR_SENSOR 

 ampli_1999_SPOT_VGT 

 large_2008_METOP 

 start_2014_PROBAV 

List file for fitted images TYPE_YEAR_SENSOR.lst 

 FITTED_1999_SPOT_VGT.lst 

 FITTED_2008_METOP.lst 

 FITTED_2014_PROBAV.lst 

List file for season parameters SENSOR_PARAM.lst 

 SPOT_VGT_ampli.lst 

 METOP_start.lst 

 PROBAV_end.lst 

Statistic output files (Process > 
Stats > Average) for fitted images 

TYPE_CROP_STAT_YEAR_SENSOR.xls 

 FITTED_GRAIN_AVG_1999_SPOT_VGT.xls 

 FITTED_COTTON_AVG_2008_METOP.xls 

 FITTED_WHEAT_AVG_2014_PROBAV.xls 

Statistic output files (Process > 
Stats > Average) for season 
images 

TYPE_BNATYPE_CROP_PARAM_STAT_SENSOR.xls 

 SEASON_MONO_GRAIN_ampli_AVG_SPOT_VGT.xls 

 SEASON_MONO_COTTON_start_AVG_METOP.xls 

 SEASON_MONO_WHEAT_end_AVG_PROBAV.xls 

Table 10: File names convention in WinDisp 



120 

 

11.3.1.1 List of values for the filenames parameters   

The list below presents the possible values for the filenames parameters. 

TYPE: type of image: 

 FITTED: the smoothed NDVI images extracted with TSF_fit2img.exe of TIMESAT 

 SEASON: the seasons parameters extracted with TSF_seas2img.exe of TIMESAT 

BNATYPE 

 MONO: monopart “.bna” file 

 MULTI: multipart “.bna” file 

YEAR: the year 

 1999 to 2015 and next 

SENSOR: the type of sensor 

 SPOT_VGT: SPOT VEGETATION 

 METOP: METOP AVHRR 

 PROBAV: PROBA-V 

DECADE: the decade as produced from TIMESAT 

 37 to 72 

PARAM: the 11 season parameters from TIMESAT 

 start: start of the season 

 end: end of the season 

 …  

CROP: the crop identified in the “.BNA” file used during the “Process > Stats > Average” 
process of WinDisp: 

 WHEAT 

 COTTON 

 POTATO 

 ... 

STAT: the type of statistic computed  

 AVG: average 

 MEDIAN: median 
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11.3.2 Importation of images into WinDisp 

The images to import into WinDisp, which are the output images from TIMESAT (stored in 

the “RESULTS” folder), are of 2 types: 

 The NDVI smoothed images, in 8-bit binary image format 

 The seasons parameters images, in 16-bits binary image format 

In this case, the importation has to be done in the folder “...\DATA\NDVI 

IMAGES\WINDISP\”. The user may test the importation process with an image of his choice. 

The importation in WinDisp can be done with the WinDisp function: 

 “Process > Import > Binary Image”.  

This function enables to import 8 or 16 bit binary images. The importation of one image can 

be done manually by using this function. The importation of a high number of images, as it is 

the case in this methodology, requires the process automation by the use of batch file, as 

described in sections 11.5 and 11.5.3. 

11.3.2.1 Parameters values of the “Import” function of WinDisp 

Note that WinDisp operates ONLY with 8-bit images and care must be taken when users are 

importing 16-bit images from other systems when using the “Process Import Binary Image” 

function. When importing 16-bit images, the correct slope and intercept (offset) values must 

be applied, if necessary, in order to scale the 16-bit pixel values (that ranges from – 32767 

to 32767) to the 8-bit pixel values (that ranges from 0 to 255). This scaling is illustrated by 

the function below: 

Slope * DN [16-bit image] + Intercept => DN [8-bit image] 

In this case, the season parameters, except the 2 integral parameters, have values in the 

range [0-255] so no conversion or scaling has to be done.  

For the 2 season parameters with pixel value higher than 255, the large and small integrals, 

a scaling has to be applied in order for these images to be correctly readable in WinDisp. 

Their values in the 16-bit images range between [0 – 10 000]. (The maximum value for a 

given decade is 255, so the theoretical maximum integral value on 1 year is: 36 * 255 = 9180 

~ 10 000). The maximum value that can be expressed in a 16-bit integer image is 32 767. In 

that latter case a scaling factor of 0.0075 would enable to obtain values not over 255 

(maximum value in 8-bit image) (32 767 * 0.0075 = 254.7). However if we consider 10 000 as 
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the largest possible value for the large integral, a scaling factor of 0.025 can be used as 

0.025 * 10 000 = 250.  

Based on that, the parameters to use with the “import” function, in this case, are 

summarized in the Table 11 below. 

Type of image to 

import 

FITTED images SEASON images 

(all except the 2 integral) 

SEASON images 

(for the 2 integral) 

Width of image 885 885 885 

Height of image 505 505 505 

Header size 0 0 0 

Scale factor 1 1 0.025 

Offset 0 0 0 

Swap bytes N N N 

Table 11: parameters values to use with the “import” function of WinDisp for Tajikistan 

 

Figure 73: “Process Import Binary Image” window for Tajikistan in WinDisp for Tajikistan 

11.3.3 Modification of image header 

The image header contains some information that enables WinDisp to display correctly the 

images (coordinates system, size and position in space of the image, size of the pixels, code 

for missing values, parameters values for the transformation of DN to real values (NDVI, 

phenology)). After the importation of the images into WinDisp, header values are not the 

right ones and consequently have to be modified. This will among other enable to:  

 Position correctly images in space. 

 Apply the right conversion of DN into NDVI or phenology values 

To access and modify the parameters values of an image header: 

 Go in the menu “Header > Edit” or “Process > Edit > Header” 



123 

 

 Browse to the image you want to modify the header (in this case the image that have 

imported into WinDisp in the previous section).  

The “header window” opens with (wrong) default values (Figure 74). Header values can be 

changed interactively in this window. 

 

Figure 74: default header values of a NDVI image after importation in WinDisp from TIMESAT 
output for Tajikistan 

The right header parameters values to be used in this case are presented in the Table 12, 

with some difference according to the sensor (SPOT-VGT, METOP AVHRR, PROBA-V) and the 

type of images (fitted NDVI vs season parameters) (Figure 75).  

Parameter Value Comment 

Image Type 
 

200, user-defined 
 

Non-predefined Image type. Parameters values 
have to be entered by the user 

Projection 3, Geographic Images are in geographic coordinate system 

Height 505 Size of the Tajikistan subset  

Width 885 Size of the Tajikistan subset 

Latitude Center 0.0 “These values identify the center of the projection 
in decimal degrees” (cf. “WinDisp4 User’s Manual”) Longitudinal Center 0.0 

X Center* 

SPOT_VGT 
-7537.5000241175 

See the explanations in the section below * 

METOP 
-7537.5000089556 

PROBA-V 
-7537.5 

Y Center* 

SPOT_VGT 
4603.5000147224 

METOP 
4604.5000179187 
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PROBA-V 
4604.5 

DX 0.0089285714 The size of the pixel in decimal degree (1 km)  
(METOP website information and images header 
file) DY 0.0089285714 

Standard Parallel 1 0 This parameter are not activated in manual edition 
of the header file for “Projection = 3, Geographic”. 
But there values must be “0” in the batch file. Standard Parallel 2 0 

Lower limit [0-255] 
1 
 

Smoothed and seasons images from TIMESAT have 
the 0 code for missing values 

Upper limit [0-255] 255 

Confer section “9. Valid data range during the 
process” 
255 is the theoretical maximum value of 8-bit 
season image 

Missing value [0-255] 0 
0 is the code given to missing values for both fitted 
and seasons images in TIMESAT 

Values slope** 

0.004  
for the NDVI images (the 
fitted images and the 2 
season images “base” and 
“max”) Season images “base” and “max” express NDVI 

values and DN have consequently to be 
transformed into NDVI values. 
 
See explanations in the section 11.3.3.2 below ** 
!! These values may have to be adapted in some 
circumstances (e.g. use of METOP AVHRR in 
continuity of SPOT-VGT): confer section 11.3.3.2.2 
below** 

1  
For other season images 

Values intercept** 

-0.1 for SPOT-VGT 
-0.08 for PROBA-V 
-0.08 for METOP 
for the NDVI images (the 
fitted images and the 2 
season images “base” and 
“max”) 

0  
For other season images 

Values decimal places 2 

The number of decimal places to use in the 

“Process/Stats” function of WinDisp. 2 decimals for 

dealing with NDVI values seem to be enough. 

(Source: “WinDisp4 User’s Manual”, page 100) 

Table 12: header parameters values to be used in WINDISP for NDVI and season images and 
justification 



125 

 

 

Figure 75: example of right header file after modification in WINDISP, the case of a smoothed 
SPOT VEGETATION NDVI image 

After the header modification, 

 Click on “Save”, which saves the modifications.  

 Possibly reopen the header to ensure that the modification has been done. 

 Possibly open the image of which you have modified the header and note that, in the 

case of NDVI image, the pixel values displayed at the bottom of WinDisp display 

window are NDVI values and no more DN value. 

The header modification has to be done for each image. To do that manually would be a 

huge work. Fortunately this operation (as others) can be automated by the use of a batch 

files. The creation and use of batch files is presented at the end of the manual in section 

11.5.2.  

Images for the period 1999-2012 (NDVI and season parameters) have already been 

imported into WinDisp and their header modified. These images are stored in the training 

package under the directory “...\DATA\NDVI IMAGES\WINDISP\”.  

The batch files used for the images importation and header modification are available in the 

folder “...\DATA\WINDISP DATA\BATCH FILES \...”.  

11.3.3.1 * X Center and Y Center of a subset image 

In order to find the right “X Center” and “Y Center” header information for IDA format, the 

WinDisp image format, it is advised to use the “FWTools/GDAL_translate” function to 

convert the SPOT VEGETATION, METOP AVHRR and PROBA-V NDVI images as extracted on 

Tajikistan, respectively with VGT EXTRACT, FWTools/GDAL_translate, and PPT from the ENVI-

standard format to IDA format. This can be done only for 3 images, 1 SPOT VEGETATION, 1 
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METOP AVHRR and 1 PROBA-V, as the “X Center” and “Y Center” will be the same for all 

images of a same sensor (same geographic properties). Once produced, the header files of 

these 2 images opened in WinDisp give their X Center and Y Center for WinDisp format, as 

presented in Table 13. This conversion can be done with the batch file 

“CONVERT_ENVI_2_IDA_FORMAT.bat” provided in the training package under the directory 

“...\DATA\NDVI IMAGES\WINDISP\GDAL_CONVERT_ENVI_2_IDA\” where the 2 converted 

images are stored as well. The X and Y Centers slightly differ between the 2 sensors, which is 

probably due to the fact that the original images on Europe extent present 1 pixel difference 

(confer Table 1 page 39). 

 SPOT VEGETATION METOP AVHRR PROBA-V 

X Center -7537.5000241175 -7537.5000089556 -7537.5 

Y Center 4603.5000147224 4604.5000179187 4604.5 

Table 13: X Center and Y Center values for SPOT VEGETATION, METOP AVHRR and PROBA-V 
images header for Tajikistan extent in WinDisp 

11.3.3.2 ** Explanation of “Slope” and “Intercept” parameters values.  

The Digital Numbers (DN) of the pixels of the images imported in WinDisp are in the range 

[0-255] as it is 8-bits images. In order to convert the DN values [0-255] to NDVI values [0-1], a 

formula needs to be applied. This formula uses a “slope” and “intercept” parameter as 

illustrated in the generic formula below: 

Slope * DN + Intercept = NDVI 

See also section “8.2. 
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NDVI images encoding” and Figure 11, page 36 for more information on NDVI images 

encoding. 

The header modification of “value slope” and “intercept” parameters concerns only the 

images of which pixels represent NDVI values, i.e.: 

 The smoothed NDVI images 

 The seasons parameters “base” and “Max”.  

The “value slope” and “intercept” parameters of the other season parameter images have to 

be set to “1” and “0” respectively in order not to apply any conversion. 

Rem: the transformation of the “base” parameter into real NDVI value can be important if 

the user would like to make a subsequent filter to suppress all pixels that would not reach a 

certain NDVI value threshold. This filter isn’t however applied in this methodology. 
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11.3.3.2.1 Original header “value slope” and “intercept” values for the 3 
sensors 

The original “value slope” and “intercept” parameter values for the 3 sensors are presented 

in the Table 14. Note that NDVI images from METOP AVHRR and PROBA-V have the same 

intercept whereas SPOT VEGETATION’s one differs. 

 SPOT VEGETATION METOP AVHRR PROBA-V 

Value slope 0.004 0.004 0.004 

Intercept -0.1 -0.08 -0.08 

Table 14: Original “value slope” and “intercept” parameters values for the 3 sensors 

These values are coming from: 

 For SPOT VEGEATION: the “VGT Extract software User Guide”. (Figure 76)  

 

Figure 76: Conversion value to convert Digital Number (DN) to physical NDVI value (source: 
VGT Extract User Guide) 

 For METOP AVHRR: the METOP AVHRR website 

(http://www.metops10.vito.be/metop-S10_pages/main.html) in the technical 

description of the spectral aspects of the images. 

 For PROBA-V: these values can be found in the header file (at the line “values”, the 2 

last numbers) of a PROBA-V NDVI image extracted with PPT in ENVI format. 

http://www.metops10.vito.be/metop-S10_pages/main.html
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11.3.3.2.2 Inter-calibration of SPOT VEGETATION and METOP AVHRR 
NDVI products for time series continuity: impact on header 
“value slope” and “intercept” values. 

 This section may be outdated as it was written in January 2013 and no update has been 

made in 2015. 

Regarding SPOT VEGETATION and METOP AVHRR, due to “problems” of inter-calibrations 

between the different sensors and/or NDVI products, the application of the original “value 

slope” and “intercept” parameters values mentioned above results in NDVI values that may 

differ between SPOT VEGETATION and METOP AVHRR image. As the METOP AVHRR NDVI 

images have to ensure the continuity [2014-2022] of the SPOT VEGETATION series [1999-

2013], NDVI values derived from these 2 sources should be identical for a given area at a 

given time. In order to ensure this compatibility the 2 types of NDVI images have to be inter-

calibrated. This can be done since the period 2008-2012 is covered by the 2 sensors. In this 

manual, it was chosen to adapt the SPOT VEGETATION NDVI values to the one of METOP 

AVHRR, so that modification will have to be made for SPOT VEGEATTION images database 

once and METOP AVHRR NDVI images won’t have to be modified for the future acquisitions. 

IF ONE WANTS TO USE METOP AVHRR INSTEAD OF PROBA-V FOR TIME SERIES 

CONTINUITY, the “value slope” and “intercept” parameters values to be used in this 

methodology for SPOT VEGETATION NDVI images, can be derived from a study comparing 

the Digital Number (DN) and NDVI physical values of the 2 considered sensors. This study has 

been realized by Herman Eerens from VITO and was available on the METOP AVHRR website 

at http://www.metops10.vito.be/metop-S10_pages/info.html, is provided in the training 

package in the “LECTURES” folder and is called 

“Comparison_NDVI_METOP_VGT_Trial2.docx”. A small difference is observed by Herman 

Eerens between the 2 sensors. The author proposes a mathematical relation between NDVI 

values of SPOT VEGETATION (NDVIVGT) and METOP AVHRR (NDVIMETOP) sensors as presented 

hereafter. 

In this case, it is necessary to transform the DN of SPOT VEGETATION images (DNVGT) into 

NDVI values comparable to the NDVI values of METOP AVHRR.  Based on the 3 following 

equations obtained by Herman Eerens: 

 NDVIMETOP = -0.08 + 0.004 * DNMETOP 

 NDVIVGT  = -0.10 + 0.004 * DNVGT 

 NDVIVGT = -0.0585 + NDVIMETOP 

It is easy to obtain the following relation (Figure 77): 

http://www.metops10.vito.be/metop-S10_pages/info.html
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 - 0.0585 + NDVIMETOP = - 0.10 + 0.004 * DNVGT 

 NDVIMETOP =  0.0585  - 0.10 + 0.004 * DNVGT = - 0.0415 + 0.004 * DNVGT 

NDVIMETOP = - 0.0415 + 0.004 * DNSPOT_VGT 

Figure 77: equation for the conversion of DN of SPOT VEGETATION NDVI image into NDVI 
values comparable to the METOP AVHRR NDVI images 

If one wants to use METOP AVHRR for SPOT VEGETATION time series continuity, the 

“value slope” and “intercept” parameters values for SPOT VEGETATION to be used in 

WINDISP are 0.004 and -0.0415 respectively. 

The user should note however that the comparison of the NDVI values of the 2 sensors for a 

given area and a given time, after that inter-calibration, shows that these values are not 

perfectly identical as presented in the next section 11.3.3.2.3. 
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11.3.3.2.3 Comparison of SPOT VEGETATION and METOP AVHRR NDVI 
values after inter-calibration for Armenia 

 This section may be outdated as it was written in January 2013 and no update has been 

made in 2015. 

The comparison of the NDVI values of SPOT VEGETATION and METOP AVHRR for a given 

area and a given time, after the inter-calibration mentioned above, shows that these NDVI 

values are not perfectly identical. Figure 78 presents the comparison of the NDVI values of 

the SPOT VEGETATION and METOP AVHRR sensors for Aragatsotn marz (province) of 

Armenia in 2008 for potato areas, after the sensors inter-calibration mentioned above. It is 

observed that, broadly speaking, METOP AVHRR NDVI values are lower than the SPOT 

VEGETATION ones for decades 1 to 22 and higher for the last decades of the year. The same 

comparisons for other marzes or for wheat result in similar difference between the 2 

sensors.  

 

Figure 78: Comparison of the NDVI values of the SPOT VEGETATION and METOP AVHRR 
sensors for Aragatsotn marz of Armenia in 2008 for potato areas, after the sensors inter-

calibration mentioned above. 

This systematic non linear difference cannot be corrected by the modification of the “value 

slope” and “intercept” parameters values which can only linearly modify the NDVI values. 

This difference is not explained yet and prevent the direct use of METOP AVHRR derived 

NDVI values to complete the SPOT VEGETATION time series. This problem has been 

reported to VITO and is currently under investigation by VITO experts… (January 2013) 



132 

 

11.3.3.2.4 Comparison of SPOT VEGETATION and METOP AVHRR season 
parameters values after inter-calibration for Armenia 

 This section may be outdated as it was written in January 2013 and no update has been 

made in 2015. 

The season parameters values computed in TIMESAT and summarized in WinDisp by Marz 

(province) seem to show a small systematic difference between the ones computed from 

SPOT VEGETATION and the ones computed from METOP AVHRR NDVI. For example, the 

start of the season is either egal (often) or earlier of 1 (often) or 2 (very rare) decades when 

computed from SPOT VEGETATION images compared to the ones of METOP AVHRR.  

However this topic has not been more deeply studied yet. This should be the object of a 

future study. 
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11.3.3.2.5 Comparison of SPOT VEGETATION and PROBA-V NDVI values 
for Tajikistan 

Considering the mean S10 NDVI values for each of the 4 provinces of Tajikistan, for the 

period 2013 11 21 to 2014 05 21, for the 2 sensors SPOT VGT and PROBA-V (Figure 79), 

SPOT-VGT NDVI values seems to be often/systematically higher than PROBA-V, especially for 

higher NDVI values (using the following scale and offset: NDVI = 0.004 DN SPOT-VGT - 0.1 

and NDVI = 0.004 DN PROBA-V - 0.08).  

Currently we don’t know how to consider this difference.  Is this due to a local 

phenomenon due to the study area or other local factor? Will this cause a problem for the 

continuity of SPOT VEGETATION time series by PROBA-V? Further investigations should be 

carried out on this topic. Currently it is proposed to used the original slope and intercept 

parameter values for PROBA-V. 

 

Figure 79: Comparison of mean NDVI values of SPOT VEGETATION and PROBA-V per 
Tajikistan province for the common time period from 2013 11 21 to 2014 05 21. 
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11.3.4 Spatial statistics computation 

Once the images are imported and their header has been modified, spatial statistics can be 

computed. This operation consists in computing the mean (or median) of pixels values by 

areas identifying the crop location by administrative unit (Armenian marzes, Tajik provinces).  

This can be done with the “Process > Stats > Average (or Median)” WinDisp function as 

described in the section 11.2.3.2 at page 115. 

In the framework of the CYF model, this statistic process has to be done for the followings: 

 All 11 season parameters images: in this case, it is necessary to create 11 list files. 

One list file will contain the 15 images (1999-2013) of a given season parameter for 

the 15 studied years. And 11 list files for the period [2014-2015] for PROBA-V. 

 All NDVI images: in this case, it is necessary to create 17 list files, one for each of the 

17 studied years (1999-2015). One list file will contain the 36 images of a given year. 

This could also be done on series of outputs of the “Process Series” function of WinDisp (list 

of “MaxDate” for example). But this will be redundant with the TIMESAToutputs. 

The list files to be used are provided in the training package under the directories 

“...\DATA\WINDISP DATA\LIST FILES\FITTED\” and “...\DATA\WINDISP DATA\LIST 

FILES\SEASON\”. These list files don’t contain “relative directory” as WinDisp don’t support 

that. Consequently, the directories mentioned in these list files have to be adapted to the 

user’s computer. This can be done with software such as “Notepad++” for example. The 

season images list files are made separately for SPOT VEGETATION images, METOP AVHRR 

and PROBA-V images (confer also the last section of section 11.5.3 at page 154). 

The boundary files to be used in the case of Tajikistan are described in the next section.  

The statistics charts resulting from this operation are the one to be used in the statistical 

part of the CYFS. 

11.3.4.1 Boundary files to use in the current CYFS for spatial statistics 
computation 

Boundary files are used for the delimitation of areas of interest for the computation of 

statistics into WinDisp on NDVI and season parameters images. One boundary file identifies 

a given crop location for each province where it is present. 3 crops are studied in this case: 

wheat, potato and cotton. 

3 boundary files have been realized and are presented in Figure 80: 

 COTTON_TAJIKISTAN_MONOPART.BNA 
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 WHEAT_TAJIKISTAN_MONOPART.BNA 

 POTATO_TAJIKISTAN_MONOPART.BNA 

These 3 boundary files are identical (except their names) as no information for each 

particular crop was available. These boundary files were roughly realised in GIS based on the 

observation of NDVI images. Up to the user to enhance them (confer next section).  

 

 

 

Figure 80: illustration of the boundary files currently used in Tajikistan for all crops. In thick 
black are the provinces boundaries. Background is the SPOT VEGETATION NDVI of 1st decade 

of June 1999. 

Boundary files have to be in “.bna” format for compatibility with WinDisp. Methodology and 

constraints to respect when building boundary files for use in WinDisp with the current 

methodology are explained the next section. 

Despite possible enhancement of these files and methodology, described below, it is 

recommended to work with these file for the time.   
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11.4 Building boundary files and possible 
enhancement 

11.4.1 Building of the boundary files 

The methodology and constraints to respect when building boundary files for use in WinDisp 

with the current CYF methodology is explained here. 

11.4.1.1 Constraints to be respected for boundary files 

First, for ease of data handling in the proposed CYFS methodology it is recommended to use 

boundary files that present one single crop polygon per administrative level of interest 

(“MONOPART” boundary files) (Marz in the case of Armenia, province in the case of 

Tajikistan). Indeed, the charts resulting from the computation with the “Process > Stats > 

Average” WinDisp function are composed of as many lines as there are spatially distinct 

areas in the boundary file used for the computation. If a “MULTIPART” boundary file is used, 

file where an area of interest is composed of several spatially distinct polygons, the resulting 

chart has to be post processed. This post processing consists in computing the mean 

parameter value per area of interest by weighting the mean parameter value of each 

spatially distinct polygon by its surface. This post-processing is fastidious in the current state 

of development of the methodology (in Excel). Possible methodology developments are 

mentioned in sections 11.4.2 and 11.4.3.  

Secondly, the boundary file format has to be “.bna” for better compatibility with WinDisp. 

Using a shapefile (*.shp) is also possible but this will result, in the first column of the output 

statistics chart, in a number instead of administrative names (eg. names of Marzes or 

provinces). Using a “*.bna” file will provide administrative names in the first column of the 

statistics chart, which is more convenient for post processing. The production of “.bna” file 

from shapefile is described below in section 11.4.1.2.2. 

11.4.1.2 Methodology for building boundary files 

The building of boundary files for use in WinDisp is made in 2 steps: 

1. Building boundary file in “shapefile” format in ArcGIS or QuantumGIS 

2. Conversion of the shapefile into a “.bna” file format for better compatibility with 

WinDisp 
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If you don’t have neither shapefile, “.bna” file nor ArcGIS, you can draw the boundary file in 

WinDisp and then create a «.bna» file from your drawing. See “On-screen digitizing », page 

46 of « Windips 4 User’s manual » for more information. 
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11.4.1.2.1 Building boundary file in “shapefile” format in ArcGIS 

It is recommended to build boundary files in ArcGIS or QuantumGIS in the shapefile format 

because shapefile creation and edition is easily done with these software. 

In this methodology, ideally, the boundary file to produce would have to represent the areas 

of a given crop for each Tajik province. The following steps can be followed: 

 Producing one shapefile per crop of interest. If the different crops are all presents in 

a same shapefile, the crop of interest can be selected and exported to a new 

shapefile. 

 Having one boundary shapefile of the administrative level of interest. For Tajikistan 

such shapefile can be downloaded for example from http://www.gadm.org.  

 Use of the function “intersect” of ArcGIS or QuantumGIS on the 2 shapefiles 

representing the crop location and the Tajik provinces.  

 Use the editing tools of ArcGIS to produce a “monopart” (confer section 11.4.1.1) 

boundary files. Pay attention to: 

o In the case that several spatially distinct crop areas are identified per 

administrative area and that the user wants to use the “monopart” approach, 

a solution is the construction of artificial thin (as thin as possible) “links” 

between crop areas of a given administrative area. However this solution is 

not elegant at all. Better (but more difficult to implement) solution is 

proposed in section 11.4.3. 

o “Hole” in polygon (inner part of a polygon that doesn’t belong to the polygon) 

is considered in WinDisp as an independent polygon. So it is important to 

avoid them and they have to be fulfilled. 

o Artefacts, very small polygons that can result from the “intersect” function 

because of none perfect overlap between intersected shapefiles, have to be 

deleted. 

 The attribute table of the resulting shapefile has to contain a column (called 

“province”) with the names of the provinces.  

 The coordinates system to be used is the Geographic coordinate system WGS84. 

The accuracy of the shapefile can be checked by exporting the shapefile to Google Earth 

(function “Layer To KML (conversion)”) and comparing the areas identified in the shapefile 

with the very high resolution images where available (confer section 11.4.2). 

http://www.gadm.org/
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11.4.1.2.2 Conversion of the shapefile into a “.bna” file format for better 
compatibility with WinDisp 

Although shapefile can be used for spatial statistics computation in WinDisp, it is 

recommended to convert them into “.bna” files for better compatibility with WinDisp 

(confer section 11.4.1.1). 

The conversion from shapefile to “.bna” can be down with the FAO freeware “SHP2BNA” 

available on the following internet website: http://www.hoefsloot.com/agrometshell.htm. 

After you downloaded “SHP2BNA” freeware to your computer, unzip it and then click on the 

“shp2bna.exe” file. The interface shown below (Figure 81) will appear. You just have to: 

 Select the shapefile you want to convert 

 Select the output directory and name (explicitly) the “.bna” file you want to create. 

 Select which attribute field (information) of the shapefile you want to be copied in 

the “.bna” file as the first and second ID of the «.bna» file. It is recommend to select 

the “province” column as the one giving the attribute to the first column of the 

«.bna» file and no attribute is selected for the 2nd column of the «.bna» file. 

 Click on “Convert” to convert your shapefile to a «.bna» file. 

 

Figure 81: « SHP2BNA » FAO freeware for conversion of shapefile to «.bna» file (the case of 
Pakistan shapefile). 

http://www.hoefsloot.com/agrometshell.htm
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11.4.2 Enhancement of the boundary files to foresee  

Both the boundary files and the method using them in the current CYFS in Tajikistan could be 

enhanced. 2 enhancements are foreseen: 

1. Using more accurate crop boundaries 

The current crop boundaries are not very accurate. Indeed these boundaries don’t delimit 
correctly crop areas. Many non crop (mountain, forest, built up, etc) areas are included in 
the current boundaries. This can be seen by overlaying the boundaries in Google Earth, as 
explained and shown below.* 
 
* Quick study of the accuracy of the boundary files in Google Earth 

The correspondence between boundary files and real land cover can be studied by 

overlaying the boundary files to satellite images in Google Earth. This can be done by doing 

the following: 

 Transforming the shapefile of interest into “KMZ” or “KML” file format for 

compatibility with Google Earth (ArcGIS function “Layer To KML (conversion)”, 

Quantum GIS function “Save vector layer as\KML”) 

 In Google Earth, comparing the shapefile boundaries and the land cover where very 

high resolution images are available. 

 Edition of the shapefile can be realized in Google Earth in order to produce more 

accurate boundaries 

 The Google Earth KML file can then be converted in shapefile in ArcGIS or 

QuantumGIS 

Figure 82 shows an example for the potato shapefile of Armenia, where many inaccuracies 

and discordance between the boundaries and the land cover can be seen (forest and 

mountain areas are included in potato boundaries). 

   

Figure 82: comparison in Google earth of the current potato boundaries used for Armenia and 
the very high resolution images 
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Note that it would be interesting to study the sensitivity of the general CYF model to the use 

of different boundary files for a given crop (crop boundary vs general province boundaries). 

2. Using “multipart” boundary files 

The creation of artificial thin tubes for “monopart” boundary file will inevitably negatively 

impact the quality of the statistics computation in WinDisp. An easy methodology should be 

developed to enable the use of multipart boundary files. That way, the mean of NDVI values 

and other season parameters per province should be computed by weighting each value 

area by its surface. Given the high number of value to handle (one value per year, crop, 

province, decade and season parameter), this would have to be done by programming, and  

for sure not manually, the later being subject to making quantity of errors.  

The use of free software such as “QGIS” (www.qgis.org/) or “R” (www.r-project.org/) should 

be studied in the purpose of finding a better methodology than the one available in WinDisp, 

and enabling the use of “multipart” boundary files. The next section gives however a 

(fastidious) solution to handle multipart shapefiles in WinDisp. 

http://www.qgis.org/
http://www.r-project.org/
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11.4.3 Computing parameter value by Marz (province) from 
multipart polygon in WinDisp.  

When using a “multipart” boundary file to compute spatial statistics with the “Process > 

Stats > Average” of WinDisp, the resulting chart will contain the parameter values organized 

in several lines per area of interest as illustrated in Figure 83, in this case several lines for a 

given Marz (columns from “C” indicate the decades). 

 

Figure 83: example of Excel chart resulting from the “Process > Stats > Average” function of 
WinDisp when using a “multipart” boundary file. 

In order to use this information in the statistical part of the CYFS, it has to be summarized by 

Marz by taking into account the relative surface of each polygon, through a sum weighted 

by area.  

The area of each spatially distinct polygon of a given boundary file can be computed in 

WinDisp by using the function “Process > Stats > count” with this boundary file. This gives 

the number of valid pixels (situated between the maximum threshold and the minimum 

threshold in a polygon) of each polygon (proportional to the area) (confer WinDisp 4.0 User’s 

manual, page 33) (Figure 84). A batch file to count the pixels from multipart bna file is 

provided under the directory “...\DATA\WINDISP DATA\BATCH FILES” and is called 

“COUNT_PIXELS_MULTIPARTS_BNA.cmd”. 

 

Figure 84: example of Excel chart resulting from the “Process > Stats > Count” function of 
WinDisp when using a “multipart” boundary file 
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In both charts resulting from “Process > Stats > Average” and “Process > Stats > Count”, the 

second column “code” contains the numeric code that WinDisp give to each spatially distinct 

polygon. This code can be used to make the junction between these 2 tables and give to 

each spatial entity its area. 

From this information it is now possible to compute the average parameter value by Marz by 

taking into account the relative surface of each spatially distinct polygon inside a Marz. The 

equation below presents the formula to be applied to compute the mean parameter value 

per Marz“VM” from the “n” units “i” of an area “Ai”, of a value Vi_M for a Marz “M”. 


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 VM, the average parameter value to be computed by Marz  

 i, a spatially distinct unit corresponding to one polygon 

 n, the number of spatially distinct units i in a given Marz M 

 M, a given Marz 

 Vi_M, the parameter mean value for a polygon i in a Marz M 

 Ai_M, the area for a polygon i in a Marz M 

 ATOTAL_M, the total area of all polygons i in a Marz M 

This computation can be realised in Excel but is fastidious. Therefore it is recommended to 

do that computation with programming software such as “R”. 

Note: the “code” produced by WinDisp doesn’t correspond to the shapefile “objectid” 

information. 
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Table 15: example of final statistics file structure for indicators derived from satellite images. D stands for “Decade” and C for “Cumul”. 

1 file per province and per crop 

 TIMESAT season parameters TIMESAT NDVI Decade NDVI cumuli Others 

Year ampli base decrease end increase large length max middle small start D1 D2 … D35 D36 C_D1_D5 C_D1_D10 … … 

1999                     

2000                     

2001                     

2002                     

2003                     

2004                     

2005                     

2006                     

2007                     

2008                     

2009                     

2010                     

2011                     

2012                     

2013                     

2014                     

2015                     

…                     

Note: if the same shapefile is used for the different crops, the statistic file for only 1 crop has to be prepared and it will be duplicated afterward. 
Origin of the different variables: 

1. TIMESAT season parameters: TIMESAT seas2img process 
2. TIMESAT NDVI Decade: TIMESAT fit2img 
3. NDVI cumuli: NDVI cumuli can easily be computed into Excel for example 
4. Others: others parameters can be computed in Excel for example. This can be the increase between given decades, etc 
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11.5 Process automation in WinDisp – batch files 

11.5.1 Introduction 

Many operations in WinDisp are repetitive, for example the importation of each of the 

images of a given time series (36 decades * 15 years (1999-2013) = 540 images to import). 

Doing each of these operations manually would take a very long time. The use of “batch” 

files enables the automation of such process, among other by introducing variables and 

looping process on these variables.  

In the case of the CYFS, image importation, header modification and statistics computation 

have to be done for all images in a few “click” thanks to the use of a batch file.  

The next sections are organised as follow: 

1. An introduction to the use of batch files (how to build and use them) 

2. The presentation of the batch files to be used in the CYFS 

!! Note !! When working with batch files you have to modify the settings of your computer in 

order for the point “.” to be the decimal symbol. !!  

11.5.2 How to build and use “batch” files in WinDisp (optional) 

Note: most of the indications in this section are extracted from the “WinDisp User’s Manual 

4.0”. This section was written and illustrated for data on Pakistan and was not updated for 

Tajikistan. Illustrations are not always in line with the indications in the text. 

11.5.2.1 Batch files 

Batch processing is an effective way to automate repetitive tasks. All of the main display and 

processing functions can be saved in a batch file to be used later. The batch file is written in 

ASCII text format, and can be easily edited. Variables, if-then statements, for-next loops, and 

goto-label jumps can be used in a batch file.  

11.5.2.2 Creating and using batch files 

To create a batch file, select “Batch > Record” from the menu. You will be asked to give a 

filename to the batch file. After this, each WinDisp 4.0 command that you execute will be 

saved to the batch file. When you are finished recording, select Batch Stop in the menu. 

These commands can now be executed again by selecting Batch Play and specifying the 
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name of the file. To see what the batch file looks like, and to make changes to it, use Batch 

Edit. If you want to execute the commands one at a time, use Batch Debug; with this option 

you can also change parameters in each step before executing them.  

11.5.2.3 Batch file format  

The basic format for a command in a batch file is:  

Function, "Parameters"  

Where Function is the menu command and "Parameters" are the parameters associated 

with this command. The "Parameters" are listed, separated by commas, in the same order as 

in the dialog box corresponding to the menu command.  

For example, a command to display an image might look like this: 

File Open Image, " c:\ccd_af\1997\Dc97073.af,,c:\data\projects\c.clr, 88,174,341,401"  

It is important to note: 

 The option Function is effected by the case of the letters used.  

 Blank lines can be used to separate groups of commands and do not have an effect 

on the execution.  

 Spaces and tabs at the beginning of a line are ignored and can be used to separate 

groups of commands.  

 Long commands can be written on several lines. The beginning and end of a 

command is designated by quotation marks. 

 Comments can be added in a batch files by denoting it as a comment line by starting 

the comment string with a # sign.  

 Variables are delimited on each side by % symbols. If the users wishes to use the % 

symbol for other than denoting a batch variable, a pair of %% symbols must be used.  

11.5.2.4 Using variables 

Repetitive tasks can be simplified by using variables in a batch file. For example, decade 

images (every 10 days) can be given file names with similar structure such as “DV02011”, 

“DV02012”, etc. It is possible to substitute the year, month and decade values by variables. It 

is also possible to use command (“prompt”) so the user will be prompted to enter the 

number of the month and dekad for the image desired. The responses will be read into the 

batch file to identify the image to display. The dialog would look like this:  

Batch Variable Prompt, "Month, Enter month desired, 7"  
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Batch Variable Prompt, "Dekad, Enter dekad desired, 3" 

File Open Image, "c:\ccd_af\1997\Dc97%Month%%Dekad%.af,,c:\data\projects\c.clr, 

0,0,0,0"  

After replacing the variables by the values attributed to them, (%Month% by 07 and 

%Dekad% by 3), the command line becomes: 

File Open Image, "c:\ccd_af\1997\Dc97073.af,,c:\data\projects\c.clr, 0,0,0,0" 

The open file can now be used to display the desired image. Note that value entered by the 

user is 7 rather that 07 in the %Month% field. 

It is important to note: 

 If you include variables in a parameter during Batch Record, the command is saved to 

the batch file. 

 Variables can be assigned values within the batch file using Batch Variables Set and 

with Batch For Begin. 

 If you include a variable in a batch but do not set its value, you will automatically be 

asked for a value during execution. 

 With Batch Variable Set you can use algebraic expressions and include other variables 

in the expression. 

11.5.2.5 Batch file exercises (not adapted to Tajik data) 

! Note that in this section, data mentioned and illustrations are not adapted to the 

Armenian case. The user should consequently adapt that by itself. ! 

Batch to open series of image. 

The problem is the following: you would like to open the 36 images of each year from 1999 

to 2012 in WinDisp. So you will have to open “36 decadal images * 14 years =504 images”. 

Of course you can do that manually but this will take you a long time. It is possible to create 

a file which enables to automate this.  

We will thus create a “batch file” which will be able to open automatically series of 36 

decadal images of a given year. The purpose is thus to create a file which automates the 

operation “OPEN IMAGE”. 

As an introduction, we will first create a batch file that allows opening automatically one 

image only. 

The first step is to create the batch file itself. To do that, in WinDisp, in the main toolbar, go 

to “Batch > Record”. Browse to the following directory where you will record the batch file: 
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“…\DATA\WINDISP DATA\batch FILES\” and name your batch file “OPEN_ONE_IMAGE.cmd” 

as indicated in the figure bellow. Do not forget the “cmd” extension. Then clic OK.  

 
 

You’ve just created an empty batch file. Now, we will have to “write” in this empty batch file. 

Be CAREFUL!, now, all the operation you will do in WinDisp (open an image, or else…) will be 

recorded in the batch file ! So DO NOT do others operation than the one you want to 

automate.  Open the first image of year 1999. For this, go to “File > Open > image” and open 

the image “DV92011.pak” in the directory “D:\VAST\in” with the NDVIE.clr color table as 

indicated in the figure below. Then click OK. The image displays. Remember this is the 

operation you want to automate. This operation has been recorded in the batch file. Then, 

go to “Batch > Stop” to stop the recording of your batch file. 

 

Now you can check the batch file you have created. Go to “Batch > Edit” and select the batch 

file “OPEN_ONE_IMAGE.cmd”. Then click OK. The following text file should appear: 

File Open Image, "D:\VAST\in\DV92011.pak, , D:\Projets\GMFS\Données de base\NDVI 

Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 

This is your first batch file. First is the name of the process, then the directory of the image 

you want to open, then the directory of the CLR table you used to open the image.  

Then, close the batch file and close the image. Now you will test your first batch file. Go to 

“batch > Play” and browse to the batch file you created in 

“…\PAKISTAN\TRAINING\WORK\OPEN_ONE_IMAGE.cmd” and clic OK. 

 

The image “DV92011.pak” automatically opens.  

Now, you will create a batch file to open series of 18 images of year 1992. Close all the 

images in windisp. Again go to “Batch > Record” and create a new batch file: 
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“…\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd” and clic OK. Go to “Batch > For 

> Begin”. The following window appears:  

 

Complete the window as indicated in the figure above. You are creating a “variable” called 

“Month” which starts from January (1) to September (9) by increment step of 1 month (each 

month between month 1 and 9 is considered). Do the same for a new variable called 

“decade” starting at 1 (first fifteen days of a month) to 2 (second fifteen days). Remember 

that for GIMM-GLCF images, there are 24 images a year, thus 2 images per month only. 

 

Then, open the first image of year 1992. For this, go to “File > Open > image” and open the 

image “DV92011.pak” in the directory “D:\VAST\in\” with the NDVIE.clr color table. Then clic 

OK. The image displays.  

Then go to “Batch > for > end” to close the “for” of “decade” and again go to “Batch > for > 

end” to close the “for” of “month”. Then, go to “Batch > Stop” to stop the recording of your 

batch file. 

Now you can check the batch file you have created. Go to “Batch > Edit” and select the batch 

file “OPEN_ONE_IMAGE.cmd”. Then clic OK. The following text file should appear: 

 Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV92011.pak, , D:\Projets\GMFS\Données de base\NDVI 
Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 

 

Close the batch file. Then go to “Batch > play > “and browse to the new batch 

file“…\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd”. Clic OK.  

Before to read the following section, try to understand what happened? Why? Can you 

comment?  
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The image “DV92011.pak » opened 18 times, this because you asked windisp to open 18 

times the same image. For month = 1 and Decade = 1, WinDisp opened the image, the same 

for month = 1 and Decade = 2, then for month = 2 and Decade = 1, etc.  

In fact WinDisp should open the image “DV92011.pak” when month = 1 and Decade = 1, 

open the image “DV92012.pak when month = 1 and Decade = 2, open the image 

“DV92021.pak when month = 2 and Decade = 1, etc. So WinDisp should open the 18 images 

from January to September 1992. 

In order to do that, you have to modify your batch file. You have to enter the variables 

(“month” and “decade”) into the process command of the batch file. You will have thus to 

modify the line 

File Open Image, "D:\VAST\in\DV92011.pak, , D:\Projets\GMFS\Données de base\NDVI 
Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 

Of the batch file “OPEN_SERIES_IMAGE.cmd” 

First close all the images with the tool “File > close All” in the main menu. Then, go to “Batch 

> edit” and browse to your batch file 

“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd” and clic OK. Now you 

will replace the “month” part of the image name “DV92011.pak” by the variable “Month” 

and replace the “decade” part of the image name “DV92011.pak” by the variable “decade” 

as indicated below with %% around each variable. 

Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV920%Month%%decade%.pak, , D:\Projets\GMFS\Données 
de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 

 

Then close your batch file. WinDisp will ask you if you want to save changes. Say Yes (OUI). In 

the “File Save Text” window, clic OK. And say Yes (oui) for overwriting. Check if your new 

batch file has been recorded correctly: go to “batch > edit “ and browse to 

“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd” and clic OK. After 

checking, close the batch file.  

Then you will play the new batch file which should open the 18 first images of 1992. Go to 

“Batch > play” and browse to 

“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd” and clic OK. The 18 

images should open as presented in the figure above: 
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To see all the opened images, go to “Window” and try successively “tile vertically” “tile horizontally” 
and “cascade”. 
 
Then go to “file > close all”. 
 
With this batch we opened 18 images only. You will now modify your batch file in order to open the 
24 images of 1992. 
 
Try to do it before reading the following section!! 
 
In order to modify your batch file, go to “Batch > edit” and browse to 
“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_IMAGE.cmd” and clic OK. You can now modify 
the batch file. 
 
 Here is the solution to open the 24 images of the year 1992: 
 

Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV920%Month%%decade%.pak, , D:\Projets\GMFS\Données 
de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 
Batch For Begin, "Month, 10, 12, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV92%Month%%decade%.pak, , D:\Projets\GMFS\Données de 
base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 

 

You just had to copy and past the text already created and modify the month of interest (10 

to 12: October to December). Be careful! You also have to modify the name of the image file: 

you have to suppress the “0” standing before the %month% variable. Indeed, here, we use 

month from 10 to 12 and no “0” is necessary anymore (not “010” to “012”). For month 1 to 

9, the “0” before the month variable was necessary because the month reference in the 

NDVI image is composed of two numbers, “01” for January for example, and the variable is 

starting from “1” to “9” and not from “01” to “09”. 
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Once this is done, save your new batch file as 

“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_24IMAGEs.cmd”. Then play the batch 

file “OPEN_SERIES_24IMAGEs.cmd”. 

 

Now imagine that you want to open images for the year 1993 the same way. What do you 

have to do ? 

You simply have to modify the year reference in your batch file as indicated below: 

 
Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV930%Month%%decade%.pak, , D:\Projets\GMFS\Données 
de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 
Batch For Begin, "Month, 10, 12, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV93%Month%%decade%.pak, , D:\Projets\GMFS\Données de 
base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 

To do that go to “Batch > edit” and browse to 

“…\Projets\PAKISTAN\TRAINING\WORK\OPEN_SERIES_24IMAGEs.cmd”. Then modify your 

batch and save it as “…\PAKISTAN\TRAINING\WORK\OPEN_SERIES_24_IMAGE_93.cmd”. 

Then play this new batch to check if it works! 

As it is not really practical to edit the batch file each time you want to execute it for a 

different year, WinDisp enables to change the year without editing the batch file. This is 

possible with the “Batch > Variable > Prompt” tool.  



153 

 

Close all your images. Then go to “Batch > record” and save a new batch file as following: 

“…\PAKISTAN\TRAINING\WORK\OPEN_SERIES_24_IMAGE_92_98.cmd”. Then go to “Batch > 

Variable > Prompt” and complete the window as below and clic OK.  

 

Then stop the recording with “Batch > Stop” and open the new batch file with the single line 

containing the “Prompt” command which look like the following: “Batch Variable Prompt, 

"Year, Year YY?, 92"” 

You created a new variable which is called « Year ». The User prompt means that the 

question “Year YY?” will appear to the user he will play the batch file. The user will then have 

to enter “93” if he want to open the 24 images for 1993. If he does not change anything the 

default value of 92 will open the 24 images of 1992.  

You have then to create a new batch file containing both the “prompt command” and the 

commands to open the images from January to December. Save this new batch file as 

following: “…\PAKISTAN\TRAINING\WORK\OPEN_SERIES_24_IMAGE_92_98.cmd”. it should 

looks like the following: 

Batch Variable Prompt, "YY, Year YY?, 92" 
 
Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV%YY%0%Month%%decade%.pak, , 
D:\Projets\GMFS\Données de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 
Batch For Begin, "Month, 10, 12, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV%YY%%Month%%decade%.pak, , D:\Projets\GMFS\Données 
de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 

 

It would be even better to be able to say to WinDisp what are the years we want to open 

images for. For example: “I would like to open all the images from 1992 to 1998 in just one 

command”. This is also possible. 

Try to find a solution before reading the following section.  
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The following batch file “OPEN_SERIES_24_IMAGE_92_98_Choose.cmd”will enables you to 

open in 1 clic 168 images from 1992 to 1998. You could also open images for a certain period 

included in 1992 to 1998.  

 
Batch Variable Prompt, "SY, Starting Year YY?, 92" 
Batch Variable Prompt, "EY, Ending Year YY?, 98" 
Batch For Begin, "YY, %SY%, %EY%, 1" 
 
Batch For Begin, "Month, 1, 9, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV%YY%0%Month%%decade%.pak, , 
D:\Projets\GMFS\Données de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 
Batch For Begin, "Month, 10, 12, 1" 
Batch For Begin, "decade, 1, 2, 1" 
File Open Image, "D:\VAST\in\DV%YY%%Month%%decade%.pak, , D:\Projets\GMFS\Données 
de base\NDVI Afrique NOAA\NOAA ARTEMIS\NDVIE.CLR" 
Batch For End, "" 
Batch For End, "" 
 
Batch For End, "" 

 

Now, try to do a batch file which enables to Window (parameters of the clip : X1 = 15, 

Y1=20, X2=100, Y2=100 ) the images from 1992 to 1998 (and to save the result in the 

following folder “…\PAKISTAN\TRAINING\WORK\ window\” and to display the resulting 

windowed file in WinDisp 

11.5.2.6 Comment on batch files 

If the batch file commands a process that creates or modifies images and that the images 

called by the batch don’t exist, the batch will create empty images as output. For example if 

you apply the batch to modify the header to the year 1998 on SPOT VEGETATION images 

where there are images from April only, the execution of the batch file will create empty 

images from January to April.   

11.5.3 Batch files for images importation, headers modification 
and computation of statistics in the CYFS 

For the CYFS in Armenia batch files for WinDisp have already been created for images 

importation, headers modification and computation of statistics. These are stored in the 

directory “...\DATA\WINDISP DATA\BATCH FILES\” and are: 
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 IMPORT_HEADER_METOP_FITTED.cmd 

 IMPORT_HEADER_METOP_SEASON.cmd 

 IMPORT_HEADER_SPOT_VGT_FITTED.cmd 

 IMPORT_HEADER_ SPOT_VGT _SEASON.cmd 

 STATS_AVG_FITTED_MONOPART.cmd 

 STATS_AVG_FITTED_MULTIPARTS.cmd (optional) 

 STATS_AVG_SEASON_MONOPART_METOP.cmd 

 STATS_AVG_SEASON_MONOPART_SPOT_VGT.cmd 

 STATS_AVG_SEASON_MULTIPARTS_METOP.cmd (optional) 

 STATS_AVG_SEASON_MULTIPARTS_SPOT_VGT.cmd (optional) 

Batch files can be adapted according to user’s need. This can be done by simple editing of 

the batch files with “Notepad++” for example. 

These batch files have to be launched from WinDisp interface through the menu “Batch > 

Play”. Be careful, when executing the batch: at the “Batch > Variable > Prompt” “Input 

Directory?” question, check that the input directory default value is the right one. It has to 

be the one mentioned at the 1st line of the batch file, in this case: 

“D:\Projets\ARMENIE\ARMENIA_CYFS_RS_2013\DATA\”. This can be adapted according to 

your computer directories organisation.  

The batch files for statistics computation call list files that are stored in the folder 

“...\DATA\WINDISP DATA\LIST FILES\”. If you don’t use the same directories organisation 

than the one proposed in this manual, adapt the directories of these list files. 

Statistics on season parameters has to be computed with different batch for SPOT 

VEGETATION and METOP AVHRR images since their header information (geographic 

features) are not exactly the same (confer section 11.3.3). 



156 

 

11.6 Excel - Computation of cumulated NDVI values 
per phenological period 

It has been showed in the literature that the cumulated (sum) values of NDVI on crop 

phenological periods (flowering,…) or other periods can be highly correlated to crop yields. 

NDVI cumuli computation can be down in 2 steps: 

 Identification of the phenological periods (or other periods of interest) of the studied 

crop 

 Computation of the cumulated (sum) NDVI values for these periods. This 

computation can be easily done in the Excel charts resulting from the “Process> Stast 

> Average” WinDisp function. However it is probably easier to handle these 

computations in programming software such as “R”.  

These NDVI cumuli can then be used in the statistical part of the CYFS as the other crop yield 

explanatory variables. 
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CHAPTER II. DATABASE UPDATES AND 

MODIFICATIONS 

Sometimes it can be necessary to make some database updates, for example in the case that 

the users want to change a computation parameter (e.g.: the start of the season threshold 

value, the missing data code, the smoothing parameters, etc). In this case the users will 

simply have to modify the desired settings in the settings files or batch files of TIMESAT 

and/or WinDisp and launch the modified process and downstream processes with the batch 

files. Except for the “TSF_process” of TIMESAT that takes approximately 30 minutes per year 

for Tajikistan extent, all other processes can be executed in a few seconds. Database updates 

and modification can thus be done very rapidly. 
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CHAPTER III. REAL TIME CROP YIELD 

FORECASTING 

12 Strategy to handle real time crop yield 
forecasting 

Crop yield forecasting has to be done in time, typically before harvest takes place and, most 

of the time, before the end of the vegetation season. In that case the NDVI curve of the 

current vegetation season is not yet completed which prevents the derivation of season 

parameters in TIMESAT.  To overcome that problem, the current year NDVI time-series has 

to be artificially completed. The proposed solution is to artificially complete the current 

time-series with the historical mean time series computed from the past year (confer 

section 12.1 below) (Figure 85).   

The completion of the time-series enables the season parameters derivation in TIMESAT. 

However only parameters not affected by this artificial season ending should be taken into 

account for the selection of the explanatory variables of the crop yield model as explained in 

section 12.2 below. Beside complementary variables can be computed in programming 

software such “R”. 

 

Figure 85: Concept of the real time crop yield forecasting from NDVI time series 
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12.1 Preparing a “historical mean” NDVI time-
series 

The proposed methodology for the preparation of the “historical mean” time-series has to 

be done in 2 steps: 

1. Computation of the “historical mean” time-series in WinDisp. 

2. Conversion of the resulting images format for compatibility with TIMESAT in ENVI 

standard format, with the “GDAL_translate” function of “FWTools 2.4.7”. So these 

images can be used to complete the current year time-series and to process it 

TIMESAT. 
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12.1.1 Computation of a “historical mean year” in WinDisp 

The “historical mean” time-series can be computed in WinDisp, although it is a fastidious 

work. A method to compute it in programming software such “R” should be developed in the 

future.  

That computation can be done with the “Process > Series > Average” function of WinDisp. It 

has to be done from SPOT VEGETATION images only. This computation has to be done on 

images already processed in TIMESAT (smoothed) and imported into WinDisp.  

The “historical mean” images time-series computation requires: 

 The realisation of as many list files as decades for which to compute the “historical 

mean” time-series (maximum of 36 list files).  For example, the list file for the decade 

25 will contain the 15 (in the case of past years = [1999-2013]) NDVI images of the 

decades 25 of the 15 SPOT-VGT years. These list files have to be made in WinDisp or 

by copy/past/edit in Notepad++. 

 The execution of the “Process > Series > Average” function of WinDisp as many times 

as there are decades for which to compute the “historical mean” time-series 

(maximum of 36 times).  This can be done with a batch file. 

The 36 list files and the batch file have already been made and are available in the following 

directories: 

 List files: “...\DATA\WINDISP DATA\LIST FILES\MEAN_1999_2013\...” 

 Batch file: “...\DATA\WINDISP DATA\BATCH 

FILES\MEAN_YEAR_1999_2013_SPOT_VGT.cmd” 

Note that, for unexplained raison, this batch file may need to be launched several times to 

properly work! 

The resulting “historical mean” NDVI images in WinDisp format are stored in the directory: 

  “...\DATA\NDVI IMAGES\WINDISP\ MEAN_1999_2013_SPOT_VGT\...” 

Figure 86 presents the comparison between the historical mean of SPOT VEGETATION NDVI 

temporal evolution for the years 1999 to 2012 (red) and the one of the year 2012 (green), 

for 3 pixels in Armenia. Note that the historical mean spectra present a little inflection at the 

decade 19. This inflection is not obvious when visualizing each of the 14 years individually 

(Figure 91). 
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Figure 86: Comparison between the mean SPOT VEGETATION NDVI temporal evolution for the 
years 1999 to 2012 (red) and the one of the year 2012 (green), for 3 pixels in Armenia 

12.1.2 Format conversion of the “historical mean year”  

As the “historical mean” time-series has to be used in TIMESAT for season parameters 

extraction, images have to be converted in TIMESAT compatible format (ENVI standard 

format). This can be done with the “GDAL_translate” function of “FWTools 2.4.7”. 

A batch file has been created in this purpose and is in the directory: 
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 “...\DATA\NDVI 

IMAGES\WINDISP\MEAN_1999_2013_SPOT_VGT\BATCH_FORMAT_CONVERSION_M

EAN_1999_2013_SPOT_VGT.bat” 

In this batch file, input files have a filename structure such as 

“MEAN_FITTED_1999_2013_SPOT_VGT_0037”, and an output filename structure such as  

 “20150101NDVI.img”. The year of the output filenames (“2015” in this case) is the year of 

the current year (the time-series to be completed). The output filename structure has to 

respect the one of the current year NDVI images found in the directory “...\DATA\NDVI 

IMAGES\ PROBAV\TAJIKISTAN\PPT_OUT\”.  

Resulting images from the execution of this batch file are stored in the directory: 

 “...\DATA\NDVI IMAGES\SPOT_VGT\MEAN_1999_2012_ENVI_FORMAT\” 

12.1.3 Completion of the current year time-series with the 
“historical mean” time-series 

When real time CYF has to be done, for example for 2015: 

1. First all available images from 2015 have to be downloaded and the database 

completed 

2. Secondly, the 2015 time-series has to be completed with the images of the “historical 

mean” time-series (1999-2013) in the directory containing the current year NDVI 

images, i.e. in the directory “...\DATA\NDVI IMAGES\ 

PROBAV\TAJIKISTAN\PPT_OUT\” (if PROBA-V images are the one used for the 

current year).  

Then the TIMESAT and WinDisp processes can be executed for the “artificially completed” 

2015 time-series.  
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12.2 Explanatory variables selection for CYF before 
the end of the vegetation season  

Given the configuration of the annual NDVI evolution in Armenia (or Tajikistan), with a 

vegetation season ending late in December (e.g. in Figure 87), numerous TIMESAT seasons 

parameters are not usable for real time CYF before the end of the vegetation season as their 

computation depends on the real end of the vegetation season. 

 

Figure 87: comparison of the current NDVI values at the first decade of September 2013 with 
the historical mean ones (mean on 1999-2012) for Tavush Marz in Armenia (fake data). 

The Table 16  presents a classification of the NDVI-derived explanatory variables depending 

on their availability for real time CYF before the end of the vegetation season.  

Type of 

explanatory 

variables 

Variables allowed in a model 

realised before the end of the 

vegetation season 

Variables NOT allowed in a model 

realised before the end of the 

vegetation season 

TIMESAT season 

parameters 

Start date , maximum value, 

increase rate 

End date, season length, base level, 

middle time, amplitude, decrease 

rate, large integral, small integral 

NDVI cumuli All cumuli that can be made 

before the date of the CYF.  

All cumuli that would include data 

after the date of the CYF 

Other parameters 

to be computed 

Date of the maximum NDVI 

value 

Decrease rate between the date 
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of maximum NDVI value and a 

later date (e.g.: maximum date 

+ 3 decades) 

Table 16: NDVI-derived explanatory variables classification depending on their availability for 
real time CYF before the end of the vegetation season. 

Only few TIMESAT season parameters (3) are available before the end of the vegetation 

season.  

NDVI cumuli can be computed on identified crop phenological period as explained in section 

11.6.  These cumuli periods can for example start at the start of the season identified by 

TIMESAT and cover different periods till the date of the CYF.  

Complementary season parameter can be computed, e.g. the date of the maximum NDVI 

value, the NDVI decrease rate between the date of the maximum NDVI value and a later 

date (e.g.: maximum date + 3 decades). This can be easily done in programming software 

such as “R”. 

Note that a strategy to overcome the “end of the season” problem could be (to be tested) to 

use of a fixed NDVI value threshold as method to identify the end of the season in TIMESAT, 

rather than the currently used “amplitude (relative) method”. This would allow identifying 

the end of the season before the minimum NDVI value at the end of the season is reached. 

12.3 The similarity approach 

Another strategy, that doesn’t require the artificial completion of the current time series, is 

the “similarity” approach. This consists in identifying for each pixel the most resembling 

NDVI curve (regarding its shape and absolute NDVI values at the time of the forecast) in the 

past years. The crop yield at the administrative level of interest (Marz, department, etc) of 

the past year resembling the most to the current year will be attributed to each pixel of the 

image for the current year. Then the mean yield is computed at the administrative level of 

interest (Marz, department, etc).  

This methodology isn’t presented here. The free software “SPIRITS” (foreseen release in 

November 2013) will contain tools for applying this methodology.  
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CHAPTER IV. COMPLEMENTARY INFORMATION 

FOR CYFS (OPTIONAL) 

Beside the crop yield forecasting itself, satellite imagery can be used to derive 

complementary information that can be useful for monitoring vegetation seasons or that are 

interesting to present in an agrometeorological bulletin.  

The next sections present some methodologies to produce this information and some 

websites providing satellite derived information relevant in this context.  

13 NDVI temporal evolution graph 

Section 11.2.2 presents a methodology to produce in WinDisp graphs expressing the NDVI 

temporal evolution. These graphs can concern one year (Figure 88) or several years, in series 

or in parallel (Figure 89 to Figure 91). This can be used to: 

 Compare the NDVI profile of a given pixel for several years  

 Compare NDVI profiles according to regions / land cover.  

To produce a graph of several years in series, the list file has to be composed of 1 column 

and as many lines as decades to be represented. To produce a graph of several years in 

parallel, the list file has to be composed of as many columns as there are of years to be 

represented and 36 lines (in the case of decadal images for 1 year) (Figure 89). A particular 

case of the later is the comparison of the NDVI values of the current year with the historical 

mean computed as explained in the section 12.1. 

WinDisp will draw graphs for pixels interactively selected in the image.  

   

Figure 88: examples of annual NDVI evolution for some pixels of Armenia 
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Figure 89: example of a graph representing the annual NDVI evolution of a given pixel in 
Armenia for 2 years in parallel, and the corresponding list file (part of it) 

Figure 90 presents an example of the NDVI temporal evolution for a “pasture pixel” in 

Armenia, for the years 2007 to 2010 from non smoothed SPOT VEGETATION images.  

 

Figure 90: SPOT VEGETATION NDVI temporal evolution (before smoothing) for the years 2007 
to 2010 for 1 pasture pixel in Armenia 
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Figure 91: SPOT VEGETATION NDVI temporal evolution for the years 1999 to 2012 for 3 pixels 
in Armenia 

Some other NDVI temporal evolution graphs are presented for different areas of Pakistan in 

Annex 1. 
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14 Stress maps 

“Stress” maps are used to highlight areas where vegetation (in this case) presents unusual 

behaviour, in particular stressed status, i.e. lower biomass development than usual, at a 

given date. 

A stress map results from the comparison of the current situation image to a reference 

“normal” situation image. This reference “normal” situation image is usually obtained by the 

computation of the historical mean of the data of interest.  

To realise a stress map for a given decade, 

1. Compute the “normal” image (historical mean), for the decade of interest. 

Methodology to compute such image is explained in the section 12.1.  

a. Create a file list of all images of the decade of interest from 1999 to 2012 for (14 

lines = 14 years) 

b. Compute the normal image of the decade of interest for 1999-2012 with the 

function “Process > Series > Average” and chose the list file created above.  

c. Give an explicit name to the output “normal” image (e.g.: 

SPOT_VGT_NORMAL_1999_2012_DECADE_55) 

d. Visualize the output in WinDisp 

Note that “historical mean” NDVI images in WinDisp format are stored in the 

directory: “...\DATA\NDVI IMAGES\WINDISP\ MEAN_1999_2012_SPOT_VGT\...” 

2. Use the “Process > Image > Difference” to produce the stress maps. Confer the 

remarque* below to understand better what this function does.  Choose as function 

parameters: 

i. A image: the “normal” image created above 

ii. B image: the current year image for the decade of interest 

a. Name the result explicitly (e.g.: DIFF_DECADE_55_NORAML_2012_SPOT_VGT) 

3. Display the image 

4. Modify the header value with slope of 1 and intercept of 0 in order to get [0-255] 

values range (or keep the NDVI transformation) 

5. Create a new colour table expressing the normal situation, the situation lower and 

higher than normal, in the example below for the [0-255] value range, with  

i. Normal situation: values around 128 

ii. Stress situation: values below 128 

iii. “Better” situation than normal: values higher than 128 
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6. Save image as “bitmap” file for exportation in report 

Note that “stress maps” can also be realized on NDVI values or seasons parameters. 

* Remarque: explanation of the “Difference” WinDisp function. Subtracting one image from 

another is a very useful way to compare two images. For instance, you can compare current 

vegetation conditions with previous conditions. This function subtracts the second image 

from the first image and rescales the result to fit in 8-bits (0-255) according to the equation 

(256+A-B)/2. In the output image, if count = 128 there is no difference, if count > 128 then 

the first image has a higher value than the second image, and vice versa. (Source: “WinDisp 

4.0 User’s Manual”). 

 

Figure 92: example of a stress maps realized for the decade 55 of 2012 on Armenia with the 
“Color Table Editor” WinDisp tool. 
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15 Realisation of animated images 

Animated GIF images can be used to show, for example, the evolution of the NDVI values for 

a given year, in Tajikistan. This consists in an animated image that displays in a short time 

interval (e.g.: 3 seconds) the 36 NDVI images of a given area. That kind of animated image is 

not really rich in information but looks good on a website. An example is provided in the 

directory “...\DOCUMENT\ANIMATED GIF IMAGE\”. It can be read with an internet browser 

for example.  

Animated GIF can be realised with software such as “GIMP” (freely available here: 

http://www.gimp.org/). 

The steps to follow to realise an animated GIF images from a series of images are the 

following (in this case, the series of images are the 36 NDVI images of a given year in 

Tajikistan): 

1. To produce the images that will compose the animation by: 

i. Opening the images in WinDisp (potentially with a batch file if the number 

of images is important) 

ii. Optionally overlay some boundary file (e.g.: Tajikistan boundary) 

iii. Saving these images as “.bmp” file with the function “File > Save > Bitmap” 

2. With a software such as Microsoft Office Picture Manager for example, (optional): 

i. Trim the images to keep only the part of the image to be used in the 

animation (same trim to apply to all images) 

ii. Compress the images in order to reduce the size of the animation (and 

consequently to enhance the display of the animation on a website) 

3. Realise the animation in GIMP: 

i. Open GIMP 

ii. Open the first image of the animation (File > Open ) 

iii. Open all the other images composing the animation as “layers” (File > 

Open as layers) 

iv. Arrange the images by chronological order in the “Layers – Brushes”  

window: the last image above, the first image below. 

v. Save the group of images as an animation with the function “File > Export”, 

give a name and use the file extension “.gif”, and click on “Export” 

http://www.gimp.org/
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vi. In the appearing window, complete the options as indicated in the figure 

below, among other: 

1. Uncheck “Interlace” and “GIF comment” 

2. Check “As animation” and “Loop forever” 

3. Select a animation speed by giving a delay between frames of your 

chose, for example 150 milliseconds 

4. Check the 2 last options 

5. And finally export 

 

i. Save your GIMP project  (File > Save as > and choose the “.xcf” 

extension) 
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16 Access to complementary information 

Some websites provide freely satellite derived information relevant in this context. 2 

websites are presented hereafter. 

16.1 Land Surface Analysis - Satellite Application 
Facility (LSA-SAF) 

The “Land Surface Analysis - Satellite Application Facility (LSA-SAF)” website, 

http://landsaf.meteo.pt/, provides many data derived from the EUMETSAT Satellite (MSG 

and EPS). 

The interested user shall have a look on that website, in particular at the “Product 

description” section. The available products are, among other: 

 SMA: Soil Moisture Availability 

 ET: Evapo-Transpiration 

 Vegetation stress 

 FVC: Fraction Vegetation Cover  

 LST: Land Surface Temperature  

Note that these products are only available for the last 3-4 years and are consequently not 

usable in the CYFS model itself.  

16.2 GEOLAND 

The Biogeophysical Parameters (BioPar) Service of the  “Geoland” website,  

http://www.geoland2.eu/portal/service/ListService.do?serviceCategoryId=CA80C981, 

provides in near real time and off-line a series of bio-geophysical parameters describing the 

continental vegetation state, the energy budget and the water cycle. Examples of data 

available are: 

 LAI: Leaf Area Index 

 FAPAR: Fraction of Absorbed Photosynthetically Active Radiation 

 FCOVER: Fraction of vegetation cover 

 NDVI: Normalized Difference Vegetation Index 

 DMP: Dry Matter Productivity 

http://landsaf.meteo.pt/
http://www.geoland2.eu/portal/service/ListService.do?serviceCategoryId=CA80C981
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Annex 1 - NDVI temporal evolution in different region 
of Pakistan with SPOT VEGETATION images of 1999 – 

2006 
 

 
NDVI evolution extracted with WinDisp from a time serie of 288 NDVI SPOT-Vegetation NDVI 

images from 1999 to 2006 

 

Figure 93 : NDVI evolution curve for year 1999 to 2006 in the central valley of Pakistan. 

 

 

Figure 94: NDVI evolution curve for year 2001 in the central valley of Pakistan: the 2 growing 
seasons RABI and KHARIF are identified. 
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